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Chapter 1 Introduction

This supplement to the ElectricImage™ Animation System program 
documentation covers the enhanced and new features of Version 2.5.

These features include:

• Inverse Kinematics

ElectricImage Version 2.5 offers selectable application of inverse 
kinematics in animating hierarchically linked groups. With 
inverse kinematics, life-like movement can be achieved more 
easily—as a group’s position and orientation change, the other 
groups in the model move as they would in real life. This feature 
is especially useful for animating human figures. This feature is 
discussed in Chapter 2: Inverse Kinematics.

• Effectors

An effector is an invisible object to which other objects can be 
linked. Operations given the effector will then be performed on 
the linked objects. This feature is useful for creating shortcuts in 
imparting certain types of motion to objects without having to 
directly animate the objects. This feature is discussed in 
Chapter 3: Effectors.
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• New lighting effects:

— Shadow Darkness provides control over the darkness or 
density of shadows cast by lights—from opaque (full shadow) 
to transparent (no shadow).

— Light Rays (volume shadows) create natural shafts of light 
when applied to a glow or fog effect on a spotlight.

— Smoke adds noise patterns to light rays, simulating smoke 
within the cone of the spotlight.

— Lens Flare Obscuration renders more realistic flare transitions 
as an object moves to obscure the lightsource.

These features are discussed in Chapter 4: Lighting Effects.

• Enhanced anti-aliasing:

Separate controls have been added for Anti-Alias Level and 
Sampling Level.

— Anti-Alias Level can be set in the range of 4 x 4 to 64 x 64.

— Sampling Level can be set in the range of 1 x 1 to 64 x 64.

You can also specify an independent Sampling Level for each 
group. These features are discussed in Chapter 5: Anti-Aliasing.

• New Image file rendering and display options:

— Image files can now be displayed within ElectricImage by 
using the File menu’s Display command.

— The view in the Camera View window can now be previewed 
fully rendered, within ElectricImage.

— The location in which images are displayed, after being 
rendered by the Camera application, can now be selected 
and set as a preference.

These features are discussed in Chapter 6: Image Display Features.

• New data cell fill techniques, collectively known as “Vibe:”

— Randomize adds random numbers to selected data cells.

— Spring impresses a complex waveform on selected data cells.

— Jolt impresses an impulse across a range of selected data cells.

These features are discussed in Chapter 7: Vibe.
1-2 ElectricImage™ Animation System
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• Two new plug-ins:

— Dicer divides groups into smaller polygons to produce better 
results when applying deformations.

— Mr. Blobby forms spheres, or blobs, out of the groups that are 
linked to it.

These features are discussed in Chapter 8: Plug-Ins.

• Control of input and output gamma. 

This feature is discussed in Chapter 9: Gamma Control.

• A new Select menu replacing the Model List menu.

The commands in the Select menu allow you to select objects in 
the World View and Project windows. They include:

— The previous Model List menu commands

— The All, Find, and Find Again commands that were previously 
under the Edit menu

— Several new commands

These features are discussed in Chapter 10: The Select Menu.

• A new value modification system:

A simple system has been implemented in ElectricImage Version 
2.5 to allow relative and percentage changes to be entered into 
the Project window cells, and into the edit boxes of most modal 
and non-modal windows. This feature is discussed in 
Chapter 6: Value Modification System.

• Multi-frame model export:

This feature works in the same manner as the File menu’s 
Save Model command, except that a range of frames can be 
specified, producing multiple versions of the model, with each 
version identified by the frame number from which it was 
exported. This feature is discussed in Chapter 12: Multi-Frame 
Model Export.

• Image file to OMFI format conversion

This standalone application converts Image stills and animations 
into Avid Technology’s Open Media Framework Interchange 
format. This feature is discussed in Chapter 13: ImageOMFI.
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• Renderama™

Renderama™ is a rendering distribution application that can be 
used to schedule batch rendering on a single computer, as well as 
to distribute rendering jobs among many networked computers. 
Jobs can be distributed across AppleTalk and TCP/IP local area 
networks as well as across TCP/IP wide area networks such as the 
global Internet. Additionally, Renderama can distribute 
rendering jobs transparently among multiple computer 
platforms including Macintosh and UNIX-based computers. This 
feature is discussed in Chapter 14: Renderama™.
1-4 ElectricImage™ Animation System
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Chapter 2 Inverse Kinematics

ElectricImage offers selectable application of inverse kinematics in 
animating hierarchically linked groups. With inverse kinematics, 
life-like movement can be achieved more easily—as a group’s 
position and orientation change, the other groups in the model 
move as they would in real life. This feature is especially useful for 
animating human figures.

�
Contents

Using Inverse Kinematics in ElectricImage ................................ 2-4

Linking Groups for Inverse Kinematics ...................................... 2-5

Configuring Groups for Inverse Kinematics .............................. 2-6

Applying Inverse Kinematics ..................................................... 2-15

Setting Kinematics Preferences ................................................ 2-26
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Using Inverse Kinematics in ElectricImage
In ElectricImage, using Inverse Kinematics (or IK) is basically a 
three-step process:

1. Setting up the hierarchy of parents and children.

This is done using the basic Link and Unlink tools to create the 
parent/child hierarchy. IK works on “chains” of linked groups.

IK works with any kind of hierarchy you assign. You are not 
restricted to working with a single linear chain—you can 
manipulate branches and multiple chains as well.

2. Configuring joint types, centers of rotation and movement 
constraints for objects in the chain.

This is done using the Group Link window, which has been 
expanded to accommodate additional controls for IK.

3. Dragging the chain into poses.

This is done with the IK tool, which is accessible from both the 
Tool palette and the Tools menu.

There are also preferences for controlling how ElectricImage applies 
IK. These preferences can be permanently set from the Edit menu and 
also be changed “on the fly” from the Kinematics palette.
2-2 ElectricImage™ Animation System
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Linking Groups for Inverse Kinematics
The first step in using IK involves linking the groups within a model 
into a hierarchy. Groups are linked and unlinked with the Link and 
Unlink tools, respectively, which are discussed in Chapter 8: The 
Project Window and in Chapter 15: The Group Link Window.

A model’s hierarchy can contain multiple “chains” and “branches,” 
as shown in Figure 2.1. In this example there are five chains and two 
branches. A branch is a group that has more than one child.

Chains in this model:

1. Torso (branch)
Neck
Head

2. Torso (branch)
Shoulder-Left
Elbow-Left
Wrist-Left
Hand-Left

3. Torso (branch)
Shoulder-Right
Elbow-Right
Wrist-Right
Hand-Right

4. Torso (branch)
Waist
Pelvis (branch)
Hip-Left
Knee-Left
Ankle-Left
Foot-Left

5. Torso (branch)
Waist
Pelvis (branch)
Hip-Right
Knee-Right
Ankle-Right
Foot-Right

Figure 2.1   Example of chains and branches in a hierarchy

1

2

3

4

5

The ElectricImage™ Reference 2-3



Chapter 2: Inverse Kinematics

2.5Book  Page 4  Wednesday, August 16, 2000  12:01 PM
Configuring Groups for Inverse Kinematics
In order to control how IK moves an individual group within a chain, 
you need to establish the group’s joint position (or pivot point), link 
type and movement constraints (if any). This is done in the Group 
Link window.

The Group Link window, as shown in Figure 2.2, has been expanded 
to contain controls for IK (on the right side of the window).

You can collapse the window to hide the controls on the right side by 
clicking the zoom box in the top right corner of the window.

Figure 2.2   Group Link window
2-4 ElectricImage™ Animation System
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Setting the Joint Position

In order for IK to be correctly applied, the joint position (or pivot 
point) of each group must be set correctly. The joint position is set by 
using either the Link Alignment Position pop-up menu or by 
interactively dragging the gnome, both of which are discussed in 
Chapter 15: The Group Link Window.

In Figure 2.3, a simplified leg model is shown before and after each 
group’s joint position is correctly set.

In this example, the upper leg will pivot at its top, where it would be 
attached to the pelvis; the lower leg will pivot at its top, which 
functions as the knee joint; and the foot will pivot at a point where 
the ankle joint would be.

�
After setting the position of the joint for a group, check in the Group 
Info window to make sure that the X, Y and Z values for the group’s 

�
center are 0, 0, and 0.

Figure 2.3   Before and after views of joint positions

Default joint 
position) for Upper 

Leg

Before After

Default joint position 
for Lower Leg

Default joint position 
for Foot

Correct joint position 
for Upper Leg

Correct joint position 
for Lower Leg

Correct joint position 
for Foot
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Setting the Link Type

After setting the position of the group’s pivot point, you’ll need to set 
the link type and any limits on its movement. There are two ways to 
assign a link type:

• Choose a link type from the Link Type pop-up menu in the left 
side of the Group Link window. Link Types are discussed in 
Chapter 15: The Group Link Window.

• Choose a pre-configured joint type from the Load Joint Type 
pop-up menu in the right side of the Group Link window.

�
ElectricImage supplies a library of pre-configured joint types for joints 
in the human body, complete with limit values. You can create your 
own joint types and libraries of joint types by saving the values you 
enter (an option in the Load Joint Type pop-up menu).

The Load Joint Type pop-up menu is described in the section “Using 

�
Joint Libraries” (page 2-12).
2-6 ElectricImage™ Animation System
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Setting Joint Limits

More precise control of the joint is handled by the controls in the 
right side of the Group Link window, as shown in Figure 2.4.

Figure 2.4   Right side of Group Link window
The ElectricImage™ Reference 2-7



Chapter 2: Inverse Kinematics

2.5Book  Page 8  Wednesday, August 16, 2000  12:01 PM
Joint Rotation Limit These controls are used to apply constraints or limits on the group’s 
ability to rotate. The pop-up menu next to each edit box can be used 
to load the current value rather than enter a number.

Enable Limits

This check box option, when enabled, places limits on the group’s 
rotation as specified in the edit boxes below. To allow unrestricted 
rotation, disable this check box.

Minimum

These edit boxes contain values in degrees for the minimum angle of 
rotation allowed for the joint.

Center

These edit boxes contain values in degrees for the angles at which the 
joint wants to be naturally positioned (at rest).

Maximum

These edit boxes contain values in degrees for the maximum angles 
of rotation allowed for the joint.

Stiffness

These edit boxes contain values that modify the strength of the pull 
to maintain the angles specified in the Center edit boxes. The higher 
the value, the more difficult it is to rotate the joint. Stiffness is 
enabled by checking the Stiffness check box.

Viscosity

These edit boxes contain values that affect the joint’s ease or fluidity 
of rotation. The higher the value, the more viscous-like the joint’s 
movement. Viscosity is enabled by checking the Viscosity check box.
2-8 ElectricImage™ Animation System
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Joint Position Limit These controls are used to apply constraints or limits on the group’s 
ability to move relative to its parent. The pop-up menu next to each 
edit box can be used to load the current value rather than enter a 
number.

Enable Limits

This check box option, when enabled, places limits on the joint’s 
movement as specified in the edit boxes below. To allow unrestricted 
movement, disable this check box.

Minimum

These edit boxes contain values that indicate the minimum distance 
the joint can move relative to the group’s parent.

Maximum

These edit boxes contain values that indicate the maximum distance 
the joint can move relative to the group’s parent.

Local Gravity These controls are used to override the global gravity setting found in 
the IK Preferences dialog box, discussed in the section “Setting 
Kinematics Preferences” (page 2-26).

Enable

This check box option, when enabled, causes the values in the 
Direction edit boxes to override the global gravity settings.

Direction

These edit boxes contain values that give direction to the group’s 
local gravity. A positive value causes gravity to effect the group in the 
positive direction along the specific axis. A negative value causes 
gravity to effect the group in the negative direction. The higher the 
value (positive or negative), the stronger the gravitation.

�
Gravity only affects how the group moves while the model is being 
dragged in IK mode, which is discussed in the section “Applying Inverse 

�
Kinematics” (page 2-15).
The ElectricImage™ Reference 2-9
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Using Joint Libraries

Joint libraries provide a means of organizing and using 
pre-configured joint types. Joint libraries are accessed and used with 
the Load Joint Type pop-up menu, as shown in Figure 2.5.

Figure 2.5   Load Joint Type pop-up menu

Select or create a joint library.

Apply a joint type from the Human 
Skeleton library.

Remove the current joint library.

Modify the current joint library.
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Libraries of joint types can be created, saved and modified using the 
Load Joint Type pop-up menu. The menu’s commands are:

Use This command allows you to select a pre-configured library of joint 
types or create a new library for the program. Choosing this 
command expands the menu to display a list of existing libraries, 
along with an option to create a new library.

If you choose New, a dialog box as shown in Figure 2.6 opens for you 
to name the new library.

You can then add joint types to the library by using the Modify 
command, as discussed in the section “Modify” (page 2-14).

Remove This command allows you to remove a library of pre-configured joint 
types from the program. Choosing this command expands the menu 
to display a list of existing libraries.

�
Once you remove a library with this command, it is permanently 
removed (erased from the disk) and cannot be used again. If the 
Human Skeleton library supplied with ElectricImage is removed and 
you wish to use it again, you must reinstall it from the ElectricImage 

�
installation diskettes.

Figure 2.6   Dialog box used to create a new library
The ElectricImage™ Reference 2-11
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Modify This command allows you to modify a joint type library by adding 
joint types, removing joint types, and updating joint types to the 
current settings. Choosing this command expands the menu to 
display a list of existing libraries.

When you choose a library from the list, a dialog box, similar to that 
shown in Figure 2.7, opens for you to select a joint type from the 
library to modify.

• To add a new joint type to the library using the current settings, 
click the Add… button. A dialog box opens for you to name the 
joint type.

• To remove a joint type from the library, click on the name of the 
joint type and then click the Remove button.

• To update a joint type in the library using the current settings, 
click on the name of the joint type and then click the Update 
button.

Figure 2.7   Dialog box used to modify a joint type
2-12 ElectricImage™ Animation System
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Applying Inverse Kinematics
IK is applied interactively—that is, by clicking and dragging. When 
used this way, the program is said to be in “IK mode.” To work in IK 
mode, you must choose the Inverse Kinematics tool and use it 
instead of the default Move tool.

Choosing the Inverse
Kinematics Tool

The Inverse Kinematics tool is available from either the Tool Palette 
or the Tools menu. The Tool Palette button is shown in Figure 2.8.

When the Inverse Kinematics tool is selected, the cursor changes 
from the standard arrow icon to the one shown in Figure 2.9.

Movement with the Inverse Kinematics tool can be in all directions, 
or constrained vertically, horizontally or diagonally. Clicking on the 
Inverse Kinematics tool in the Tool Palette and pressing the Tab key 
cycles through these options, changing the appearance of the tool as 
shown in Figure 2.10.

Figure 2.8   Default Inverse Kinematics tool

Figure 2.9   Cursor icon in IK mode

Figure 2.10   IK tool options

Move in all 
directions

Move 
diagonally

Move 
horizontally

Move 
vertically
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Using the Inverse
Kinematics Tool
to Pose a Model

When the IK tool is highlighted in the Tool palette, you are in IK 
mode and inverse kinematics will be applied when you drag a group 
that is hierarchically linked to other groups. What happens when 
you drag the group is determined by:

• Which groups, if any, are selected when the IK tool is applied.

• The number of chains and branches in the model’s hierarchy.

• The dragged group’s position in the chain’s hierarchy.

• The link and joint types of all groups in the hierarchy.

• The limits, if any, on the joints of each group in the hierarchy.

• The IK preference settings.

IK preferences are set by either an Edit menu command or the 
Kinematics palette, which contains a subset of the options 
available in the Edit menu command. Preferences are discussed 
in the section “Setting Kinematics Preferences” (page 2-26).

Figure 2.12, starting on the next page, shows examples of how IK 
mode selection works in various situations. Figure 2.11, below, 
contains a key to the elements in Figure 2.12.

Figure 2.11   Key to elements used in Figure 2.12

Top parent group

Branch group

Selected

Selected

Selected, but with
locked position

Unselected

Unselected

Unselected 

Portion of chain 
affected by IK
2-14 ElectricImage™ Animation System



Applying Inverse Kinematics

2.5Book  Page 15  Wednesday, August 16, 2000  12:01 PM
Figure 2.12   How IK mode selection works  

Condition Action Result

When no groups are pre-selected…

If you start with no groups 
pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will select the groups 
as shown below and affect 
the selected groups in the 

highlighted chain.

If you start with no groups 
pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will select the groups 
as shown below and affect 
the selected groups in the 

highlighted chain.
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When groups in a single chain are pre-selected…

If you start with the group 
shown below pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will affect the selected 
group only (with default setting 

of phantom joint enabled).

If you start with the group 
shown below pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will select the groups 
as shown below and affect 
the selected groups in the 

highlighted chain.

Figure 2.12   How IK mode selection works  (continued)

Condition Action Result
2-16 ElectricImage™ Animation System
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If you start with the groups 
shown below pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will affect the selected 
groups in the highlighted chain.

If you start with the groups 
shown below pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will affect the selected 
groups in the highlighted chain.

Figure 2.12   How IK mode selection works  (continued)

Condition Action Result
The ElectricImage™ Reference 2-17
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If you start with the groups 
shown below pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will deselect the group 
as shown below and affect 
the selected groups in the 

highlighted chain.

If you start with the group 
shown below pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will select the groups 
as shown below and affect 
the selected groups in the 

highlighted chain.

Figure 2.12   How IK mode selection works  (continued)

Condition Action Result
2-18 ElectricImage™ Animation System
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If you start with the groups 
shown below pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will select the groups 
as shown below and affect 
the selected groups in the 

highlighted chain.

If you start with the groups 
shown below pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will select and deselect 
the groups as shown below and 
affect the selected groups in the 

highlighted chain.

Figure 2.12   How IK mode selection works  (continued)

Condition Action Result
The ElectricImage™ Reference 2-19
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If you start with the group 
shown below pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will select and deselect 
the groups as shown below and 
affect the selected groups in the 

highlighted chain.

When groups in multiple chains are pre-selected…

If you start with the groups 
shown below pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will select and deselect 
the groups as shown below and 
affect the selected groups in the 

highlighted chain.

Figure 2.12   How IK mode selection works  (continued)

Condition Action Result
2-20 ElectricImage™ Animation System
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If you start with the groups 
shown below pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will not be 
implemented.

If you start with the groups 
shown below pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will deselect the group 
as shown below and affect 
the selected groups in the 

highlighted chain.

Figure 2.12   How IK mode selection works  (continued)

Condition Action Result
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If you start with the groups 
shown below pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will affect the selected 
groups in the highlighted chains 
(except that the lowest group in 
each chain is locked in position).

If you start with the groups 
shown below pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will affect the selected 
groups in the highlighted chains 
(except that the lowest group in 
each chain is locked in position).

Figure 2.12   How IK mode selection works  (continued)

Condition Action Result
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Accepting a Solution While holding down the mouse button and dragging a group, the 
program will compute solutions for the position and rotation of all 
affected groups in the chain. IK preference settings, discussed in the 
section “Setting Kinematics Preferences” (page 2-26), can instruct the 
program to find an exact solution and also specify the maximum 
amount of time the program can take to find the exact position. If an 
exact solution cannot be determined in that amount of time, 
whatever solution has been derived at that point will be used.

While the program is processing, the cursor icon changes to the one 
shown in Figure 2.13.

You can release the mouse button while the program is processing to 
accept the current solution, or wait until a more exact solution is 
presented. 

If you start with the groups 
shown below pre-selected…

And you click and drag the group 
shown below with the IK tool…

IK mode will affect the selected 
groups in the highlighted chains 
(except that the lowest group in 
each chain is locked in position).

Figure 2.12   How IK mode selection works  (continued)

Condition Action Result

Figure 2.13   Cursor icon in IK mode during processing
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Setting Kinematics Preferences
Preferences for how Inverse Kinematics is applied can either be set as 
defaults for continuous usage or “on the fly” through the use of the 
Kinematics palette (page 2-29).

The Kinematics… Command

To set default preferences for Inverse Kinematics:

1. Choose Kinematics… from the Edit menu.

A dialog box, as shown in Figure 2.14 below, opens.

2. Use the controls to set your preferences. For an explanation of 
these controls, see the section “Kinematics Preferences” 
(page 2-27).

3. To save the preferences, click OK or press Return.

�
To reset the system’s default preferences at any time, choose 

�
Default Preferences from the Edit menu.

Figure 2.14   Kinematics Preferences dialog box
2-24 ElectricImage™ Animation System



Setting Kinematics Preferences

2.5Book  Page 25  Wednesday, August 16, 2000  12:01 PM
Kinematics Preferences

Inverse Kinematics
Options

While dragging the chain…

The following three check box options control what happens to 
groups being dragged when a chain of groups is dragged. These check 
boxes are duplicated on the Kinematics palette for setting preferences 
“on the fly.”

• Use Phantom Joint

This check box option, when enabled, allows rotation of a child 
relative to its parent. If disabled, the child will not rotate.

• Use Global Gravity

This check box option, when enabled, turns on global gravity, 
the values for which are set in the Global Gravity edit boxes 
(page 2-28).

• Keep World Orientation

This check box option, when enabled, locks the rotation of 
groups in the chain in global space.

Deselected joints in chain…

The following two check box options control the movement of 
groups in a chain that have been deselected (while the remaining 
groups in the chain remain selected). These check boxes are 
duplicated on the Kinematics palette for setting “on the fly.”

• Lock Rotation

This check box option, when enabled, causes stiffness by 
preventing the deselected group(s) from rotating.

• Lock Position

This check box option, when enabled, attempts to prevent a 
change of position of the deselected group(s). At a certain point, 
however, pulling on the chain will yank the group free because 
the group may have to change its position in order to maintain 
its place in the chain.
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Solution Options These controls affect how the program determines a solution for the 
position and rotation of all elements in a chain. For information on 
how the cursor is affected during processing, see the section 
“Accepting a Solution” (page 2-25).

Find Exact Solution

This check box option, if enabled, requires the program to find the 
exact solution. If disabled, the temporary solution used at the point 
when you release the mouse button is applied.

Solution time

This edit box contains a value in seconds that sets a limit on the 
amount of time the program can use to arrive at a solution.

Constraint Multipliers These edit boxes contain values that establish the relative importance 
of Position, Orientation, Stiffness, Viscosity and Gravity when 
applying IK. The higher the value for an attribute, the greater 
importance is placed on that attribute.

The best way to use these controls is to observe their effects. If, for 
example, you want more viscosity in a group’s movement, increase 
the value for viscosity.

Global Gravity These edit boxes contain values for the X, Y and Z direction of gravity 
to be applied to groups in a chain. Normal earth gravity would be 
zero for the X and Z axes and a negative value for the Y axis.

�
Gravity only affects how the group moves while the model is being 
dragged in IK mode, which is discussed in the section “Applying Inverse 

�
Kinematics” (page 2-15).
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The Kinematics Palette

The Kinematics Palette, shown in Figure 2.15, is a floating palette 
that contains a subset of the controls from the Edit menu’s 
Kinematics… command. It is used to change some of the IK 
preferences “on the fly.”

The Kinematics palette is opened from the Windows menu.

While dragging
the chain…

The following three check box options control what happens when a 
chain of objects is dragged. These check boxes are duplicated on the 
Kinematics palette for setting preferences “on the fly.”

Use Phantom Joint

This check box option, when enabled, allows rotation of a child 
relative to its parent. If disabled, the child will not rotate.

Use Global Gravity

This check box option, when enabled, turns on global gravity, the 
values for which are set in the Global Gravity edit boxes.

Keep World Orientation

This check box option, when enabled, locks the rotation of objects in 
the chain in global space.

Figure 2.15   Kinematics Palette
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Deselected joints
in chain…

The following two check box options control the movement of 
objects in a chain that have been deselected (while the remaining 
objects in the chain remain selected). These check boxes are 
duplicated on the Kinematics palette for setting “on the fly.”

Lock Rotation

This check box option, when enabled, causes stiffness by attempting 
to prevent the deselected object(s) from rotating.

Lock Position

This check box option, when enabled, attempts to prevent a change 
of position of the deselected object(s). At a certain point, however, 
pulling on the chain will yank the object free because the object may 
have to change its position in order to maintain its place in the 
chain.
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Chapter 3 Effectors

ElectricImage offers a special object class, called Effectors.

An effector is an invisible object to which other objects can be linked. 
Operations given the effector will then be performed on the linked 
objects.

This feature is useful for creating shortcuts in imparting certain types 
of motion to objects without having to directly animate the objects.

�
Contents

Adding Effectors ............................................................................ 3-4

The Effector Info Window ............................................................ 3-5
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Adding Effectors
To add an effector to a project:

1. Either choose Add> then Effector… from the File menu or click 
the Effector icon in the Object palette (as shown at left).

The cursor will change, as shown in Figure 3.1.

2. Place the cursor in a World View window where you want to add 
the effector, and click.

The effector appears in the World View windows with an icon as 
shown in Figure 3.2.

The first effector added to a project is called “Effector 1.” Each 
successive effector is numbered in sequence.

3. When you are done adding effectors, select the Move tool from 
either the Tool palette or the Tools Menu.

�
Once an effector is added to a project, its position and rotation can be 
animated. You can also rename effectors in the same manner as 

�
renaming other objects (in the Project window).

Figure 3.1   Cursor for adding an effector

Figure 3.2   Icon for an effector in the World View windows
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The Effector Info Window
The Effector Info Window, as shown in Figure 3.3, is similar in use to 
the Group Info window.

Style This pop-up menu offers a choice for how the effector is displayed in 
the World View windows. The choices are:

• Cross (the default)

This option causes the effector to be displayed as shown in Step 2 
(page 3-4).

• Box

This option causes the effector to be displayed as a group would 
be displayed—that is, with a bounding box.

Show Bounding Box This check box option toggles the display of the bounding box 
around the effector (if Box is chosen from the Style pop-up menu 
and extent sizes are specified in the Extent Size edit boxes).

Extent Size These edit boxes contain values that control the size of the effector’s 
bounding box (if Box is chosen from the Style pop-up menu). If Box 
is chosen and the extent size values are left at zero, the effector will 
be visible in the World View windows by only a small point.

Figure 3.3   Effector Info window
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Chapter 4 Lighting Effects

There are several new lighting effects available in ElectricImage 
Version 2.5:

• Shadow Darkness provides control over the darkness or density 
of shadows cast by lights—from opaque (full shadow) to 
transparent (no shadow).

• Light Rays (volume shadows) create natural shafts of light when 
applied to a glow or fog effect on a spotlight.

• Smoke adds noise patterns to light rays, simulating smoke 
within the cone of the spotlight.

• Lens Flare Obscuration renders more realistic flare transitions as 
an object moves to obscure the lightsource.

Contents

Shadow Darkness........................................................................... 4-2

Light Rays ....................................................................................... 4-3

Smoke .............................................................................................. 4-5

Lens Flare Obscuration................................................................ 4-10
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Shadow Darkness
Shadow Darkness provides control over the darkness or density of 
shadows cast by lights—from opaque (full shadow) to transparent 
(no shadow).

To control the darkness of shadows cast by a light:

1. Select the light and open the Light Info window.

The Darkness edit box is found in the Shadow Info section of the 
Light Info window, as shown below.

The shadow’s Darkness value defaults to 1.0, which produces a dark 
(fully opaque) shadow.

2. To decrease the darkness of the shadow, enter a value between 
0 and 1 in the Darkness edit box—the smaller the number, the 
lighter (or less dense) the shadow.

Figure 4.1   Shadow Info section of Light Info window
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Light Rays
Light Rays (volume shadows) can be used to create natural shafts of 
light when applied to a glow or fog effect on a spotlight. They cause 
the cone of the spotlight to behave as a realistic light source.

When light rays are applied, the shaft of light will be partially 
blocked when it is interrupted by groups in your project. Since the 
shaft can be partially blocked, you can place cut-outs in front of the 
shaft to create shaped shadows and spots. In theatrical lighting 
terms, you can create gobos, cucoloris, and dingles.

w
Light rays do not pass through transparent groups or groups with 
transparency maps. This can be used to some advantage, however. A 
transparent (invisible) plane may be animated to cause the end point 
of the rays to move through space, creating exciting effects for logo 
work.

To create light rays:

1. Select the light and open the Light Info window.

2. Choose Spot from the Light Modes pop-up menu.

This sets the light type to spotlight.

w
Because the light streak effect uses the shadow buffer of spotlights 
to function, the light mode must be set to Spot and shadows must 
be enabled.

3. Click the Enable Shadow check box to enable shadows.

The Light Rays controls are found in the Special Effects section of the 
Light Info window, as shown in Figure 4.2 (page 4-4).

4. Click the Enable Glow check box to enable the glow effect (or 
click the Enable Fog check box to enable a fog effect), and 
configure the glow/fog for color, radii, factor, intensity.

5. Click the Enable Ray check box (beneath the appropriate 
glow/fog section) to enable the light rays effect.
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The Ray Factor value defaults to 1.0, which produces very dark (high 
contrast) rays.

6. To decrease the darkness of the rays, enter a value between 
0 and 1 in the Ray Factor edit box—the smaller the number, the 
lighter (or with less contrast) the rays.

7. To control grain in the rays, enter a value in the Ray Sample 
edit box.

The value in this edit box determines how many samples are 
taken to calculate the streak intensity through the cross-section 
of the spotlight cone. Increasing the value reduces grain in the 
rays (at the expense of processing speed, however).

w
The Smoke pop-up menu is used to assign a smoke object to the light for 
creating smoke within the cone of the spotlight. This feature is 
discussed in the section “Smoke” (page 4-5).

Figure 4.2   Special Effects section of Light Info window
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Smoke
Smoke is a mathematical function generator that adds noise patterns 
to light rays. The noise patterns will appear to create smoke within 
the cone of a spotlight. To use this feature, light rays must be 
configured for the spotlight, as described in the section “Light Rays” 
(page 4-3), and a smoke object must be added to the project and 
assigned to the light.

To create smoke:

1. Add a smoke object to the project.

This can be done in either of the following ways:

• Choose Add> then Smoke… from the File menu.

• Click on the smoke object icon in the Object Palette, as 
shown above left.

The cursor icon changes, as shown in Figure 4.3.

2. Click and drag in the World View windows to place the smoke 
object.

The smoke object appears as a box within your project. The size of the 
box is determined by the size of the rectangle you drag when you place 
it. The first smoke object added to a project has a default name of 
“Smoker 1.” Subsequent smoke objects are numbered 2, 3, etc.

w
You do not need to place the smoke object in front of a light in 
order for the smoke effect to be seen in that light. You can 
therefore use the same smoke object for multiple lights. When you 
animate the smoke object’s position and rotation, the smoke 
within the cones of all spotlights to which the smoke object is 
assigned will appear to drift.

3. Select the light to be configured for the smoke effect and open 
the Light Info window.

Figure 4.3   Cursor icon when adding a smoke object
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4. Configure the light for light rays.

• Choose Spot from Light Modes pop-up menu.

• Click Enable Shadow.

• Click Enable Glow (or Enable Fog) and configure the 
glow/fog for color, radii, factor, intensity.

• Click Enable Streak.

Refer to the section “Light Rays” (page 4-3) for more 
information, if necessary.

5. Choose the smoke object from the Smoke pop-up menu, 
located under the glow or fog effect controls.

The Smoke Info window, as shown in Figure 4.4, opens.

6. Use the controls of the window to configure the smoke to your 
preferences. For an explanation of these controls, refer to the 
section “Smoke Controls” (page 4-7).

Figure 4.4   Smoke Info window
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Smoke Controls

Show Smoke Object This check box option, enabled by default, toggles the display of the 
smoke object in the World View windows.

Scale This edit box contains a value that determines the scale at which the 
visible portion of the smoke effect is rendered. The greater the value, 
the smaller the “globs” of smoke.

Position,
Rotation
and Size

These edit boxes contain values that define the smoke object’s 
position, rotation (orientation) and size in global space.

Mist This edit box contains a value from 0 to 1 that sets the ambient 
smoke level of the scene. A value of 0 is no ambient (rays will not 
show). A value of 1 is a completely white smoke volume.

Contrast This edit box contains a value that controls the contrast between the 
light and dark sections of the smoke. 

Density This edit box contains a value that controls how much smoke is in 
the unit volume. A value of 0 is a completely smokeless volume. A 
value of 1 causes the smoke function to be enabled throughout the 
volume.

Noise This edit box contains a value from 0 to 1 that controls the detail in 
the smoke. Values below 0.5 give a smoother effect. Values above 0.5 
add more detail to the smoke. If you increase the noise value past 0.5, 
try increasing the Linear Detail value (discussed below) as well.

Samples This edit box contains a value that determines whether the smoke is 
2-dimensional (value 1), or 3-dimensional (value > 1). 2D smoke will 
render much faster than 3D, but if you need to move the camera 
through the scene, 2D smoke will seem flat.

Limit This edit box contains a value that applies only if the Samples value 
is greater than 1. It limits the maximum number of depth samples to 
be evaluated for the smoke. Setting the value above 200 will increase 
the render time.
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Bicubic Detail This edit box contains a value that controls how many fractal levels 
are computed using bicubic computation. Bicubic computation 
produces smoother areas of smoke, but at the expense of slower 
rendering times. The higher the value, the greater the detail in the 
smoke. Both bicubic and linear computation (below) can be used in 
combination.

Linear Detail This edit box contains a value that controls how many fractal levels 
are computed using linear computation. Linear computation 
produces ridge-like, horizontal and vertical areas of smoke, less 
“realistic” than bicubic detail (above) but faster to render. The higher 
the value, the greater the detail in the smoke. Both linear and bicubic 
computation can be used in combination.

Octave This edit box contains a value that controls how many layers of 
turbulence appear within the unit cube of smoke. The layers default 
parallel to the XZ axis. Changing the Rotation value will change this 
orientation.

Drift This edit box contains a value that moves the layers through the 
turbulence. The range of possible values is dependent on the number 
of layers you create using the Octave control. Plus 1.5 will move one 
and a half layers through the turbulence. 

Turbulence This check box option and edit box enables a turbulence function 
that mixes the layers into each other. The edit box contains a value 
from 0 to 1 that controls how much the layers are folded into each 
other. A value of 0 keeps the layers separated. A value of 1 completely 
mixes the layers together.

Preview Window This window is used to obtain a preview of the smoke effect that will 
appear in the smoke object. If the smoke is 3D, as set in the Samples 
edit box, the view will represent a slice of the smoke.

w
The preview window offers only an approximation of the smoke effect. 
You must render the image to see exactly what the smoke will look like.
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Preview
Offset

These edit boxes contain values that offset the image in the preview 
window. Values of 0 for the X, Y and Z edit boxes center the image in 
the preview window. Scrolling the preview window will change the 
values in the Offset edit boxes. Offsetting the Z value changes the 
depth at which the viewing slice is taken.

Preview
Depth

This edit box contains a value that corresponds to the depth of the 
slice shown in the preview window for a 3D smoke effect.
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Lens Flare Obscuration
In previous versions of ElectricImage, lens flare obscuration was a 
binary function—that is, either the lens flare and light source were 
visible or invisible.

Version 2.5 has more realistic obscuration effects. As the source of 
light is obscured by a group, it begins to dim naturally, fading to zero 
intensity when the light is totally obscured.

The size of the light source is defined in world units and is controlled 
by the Size: edit box within the Light Info window.

The Show Size check box can be used to display the size of the light 
in the World View windows.

w
For obscuration to work, you must check the Enable Obscuration check 
box in the Light Info window for the configured light.
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Chapter 5 Anti-Aliasing

ElectricImage Version 2.5 has a much improved anti-aliasing system.

• Separate controls have been added for Anti-Alias Level and 
Sampling Level.

— Anti-Alias Level can be set in the range of 4 x 4 to 64 x 64.

— Sampling Level can be set in the range of 1 x 1 to 64 x 64.

• You can now specify an independent Sampling Level for each 
group.

Contents

Anti-Aliasing and Sampling Levels ............................................. 5-2

Usage Tips ....................................................................................... 5-4
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Anti-Aliasing and Sampling Levels
In previous versions of ElectricImage, the Oversample method of 
anti-aliasing was equivalent to an Anti-Alias Level of 4 x 4 and a 
Sampling Level of 1 x 1 (these are the default settings in Version 2.5). 
The Supersampling check box in previous versions changed the 
Sampling Level to 2 x 2.

Figure 5.1 shows the new anti-aliasing controls in the Render Control 
window.

Anti-Alias Level This pop-up menu offers the following options for setting global 
anti-aliasing levels:

• 4 x 4 (the default)

• 8 x 8

• 16 x 16

• 32 x 32

• 64 x 64

Sampling Level This pop-up menu offers the following options for setting global 
sampling levels:

• 1 x 1 (the default)

• 2 x 2

• 4 x 4

• 8 x 8

• 16 x 16

• 32 x 32

• 64 x 64

Figure 5.1   Anti-aliasing controls in the Render Control window
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The sampling level can be set at the individual group level by using 
the Sampling Level pop-up menu in the Group Info window, as 
shown in Figure 5.2.

The options in the pop-up menu allow you to specify a specific 
sampling level for the group (which will be overridden by the global 
setting in the Render Control window if the global level is lower).

The Automatic option causes the group’s sampling level to be 
controlled by the Sampling Level pop-up menu in the Render 
Control window.

Figure 5.2   Group Info window
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Usage Tips
High contrast vertical edges next to horizontal edges can cause 
aliasing artifacts at 4 x 4 anti-aliasing. Higher anti-aliasing levels 
should be used to reduce moire patterns that can appear in your 
renderings (with only a moderate impact on rendering times).

On occasion, high-frequency details, such as an edge with a highlight 
or the highlights that appear on bump maps, will have a stair-step 
pattern or will flash off and on during animations. Higher sampling 
levels will reduce this high-frequency noise and improve the 
sharpness of texture maps. But using a higher sampling level will 
have a dramatic impact on rendering time. Rendering your whole 
project in 2 x 2 sampling instead of 1 x 1 can quadruple rendering 
time. That is why we have provided the ability to set the sampling 
level independently for each group in your project. This control has 
been added to the Group Info Window.

w
As a general rule, make the Anti-Alias Level four times the Sampling 
Level. This tends to yield the highest quality images. If you need to 
increase the Sampling Level to 2 x 2 for even one of your groups, 
increase your Anti-Alias Level to 8 x 8.

Setting the Sampling Level higher than the Anti-Alias Level will not 
improve image quality and slows down rendering.

The sampling level set in the Render Control window acts as a global 
limit. In other words, it sets the maximum sampling level for all 
objects in the scene. If you set some of your groups to a sampling 
level of 4 x 4, but the level in the Render Control window is set to 
1 x 1, all groups will render at 1 x 1.
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Chapter 6 Image Display Features

ElectricImage Version 2.5 has several new features related to the 
rendering and display of Image files:

• Image files can now be displayed within ElectricImage by using 
the File menu’s Display command.

• The view in the Camera View window can now be previewed 
fully rendered, within ElectricImage.

• The location in which images are displayed, after being rendered 
by the Camera application, can now be selected and set as a 
preference.

Contents

The Display Command .................................................................. 6-2

Display Preferences  6-5

Previewing the Camera View....................................................... 6-6

Display Location............................................................................. 6-8
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The Display Command
The File menu’s Display command now displays Image files as well as 
QuickTime movies. By default, the selected Image file appears in a 
floating window, as shown in Figure 6.1. You can, however, set 
preferences for the Display command, as discussed on the next page.

The display window is added to the list of windows in the Windows 
menu so that you can choose it and bring it to the front once it has 
been covered by other project windows.

The vertical slider bar adjusts which frame of the Image file is being 
displayed (for animations). The frame number is shown just below.

The left side of the window contains the following controls:

This button pops up a small window containing basic data about the 
Image file being displayed.

This button allows the Image file’s color and alpha channels to be 
turned off and on.

Figure 6.1   Image Display window
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This button allows the background color of the Image file to be 
changed or overridden.

This button enables you to select the frame number of the Image 
animation to be displayed (as an alternative to the vertical slider bar).

This button switches to full screen display. Any mouse click will 
switch back. While in full screen display, the following keystroke 
actions are available:

• Up and Right arrow keys advance animations a frame at a time.

• Down and left arrow keys step back animations a frame at a time.

• Space bar selects the scroll tool.

• Command-space bar selects the zoom-out tool.

• Command-Option-space bar selects the zoom-in tool.

• The following command key combinations switch the color 
display mode:

— Command-0: RGB

— Command-1: Grayscale

— Command-2: Red only

— Command-3: Green only

— Command-4: Blue only

— Command-5: Alpha only

This button opens a standard Save dialog box that enables you to 
save the displayed Image file to disk.

This button selects the standard move tool. It is pre-selected by 
default when the window opens.

This button selects the zoom-in tool. It can also be selected by 
pressing Command-Option-space bar. Pressing the Option key while 
the zoom-in tool is selected changes the tool to the zoom-out tool, 
which can also be selected by pressing Command-space bar.

This button selects the scroll tool, which is used to scroll an image 
that is larger than the display window. It can also be selected for 
temporary use by pressing the space bar.
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To set preferences for the Display command:

1. Choose Display… from the Edit menu.

A dialog box, as shown in Figure 6.2 below, opens.

2. Use the controls to set your preferences. For an explanation of 
these controls, see the section “Display Preferences” (page 6-5).

3. To save the preferences, click OK or press Return.

w
To reset the system’s default preferences at any time, choose 
Default Preferences from the Edit menu.

Figure 6.2   Display preferences dialog box
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Display Preferences

Display Images in
Windows

This radio button, the default, displays Image files in a window.

Display Images in Screen This radio button, when selected, displays Image files on the screen 
rather than using a window.

Center Image on Screen This check box (for screen display only) centers the image on the 
screen.

Hardware Alpha Overlay This check box (for screen display only) is used with a video card that 
supports blending graphics on top of video.

Invert Alpha This check box (for Hardware Alpha Overlay only), when enabled, 
inverts the alpha channel to achieve the correct overlay of graphics 
on video.

Color Display This pop-up menu sets the color channel to be displayed. Choices are 
RGB, Red, Green, Blue, and Alpha.

Automatic Screen Depth This check box sets the color bit depth of the monitor to that of the 
Image file being displayed.

Premultiply Alpha This option, when enabled, multiplies the alpha channel into the 
RGB channel. If, for example, the alpha channel value is 128 (50%), 
then 50% of the color will display.

Display Components
in Gray

This check box option, when enabled, causes a grayscale display 
when the Red, Green or Blue color channels are selected from the 
Color Display pop-up menu.

Change Background
Color

This option, along with the color button to its right, allows you to 
select a color with which to override the background color of the 
Image file.

Select Display Monitor This control selects the monitor for displaying the Image file (in a 
multi-monitor set-up).
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Previewing the Camera View
The current image in the Camera View window can now be 
previewed fully rendered (i.e., with lighting, textures, reflections, 
etc.). You can choose to preview the entire image or select an area of 
the image to be previewed. Rendering occurs in the background, 
enabling you to continue project set-up and editing.

w
To use this feature, your system must have enough memory (RAM) to 
allow both the ElectricImage and Camera applications to run 
simultaneously.

w
This feature can cut a huge amount of time from the animation set-up 
process. Scene lighting can be quickly evaluated, modified, and 
evaluated again. Complex material and mapping attributes can also 
benefit from quick and accurate previews.

To preview the Camera view:

1. Click on the icon shown at left (located at the bottom of the 
Camera View window), hold down the mouse button and 
choose one of the four options from the menu that pops up.

• To preview the Camera view at the current size of the 
window in the Camera View window, choose Window Size.

• To preview the Camera view at the project’s resolution (as 
set in the Render Control window), choose Full Size.

• To select an area to be previewed at the size of the standard 
Camera View window, choose Selected Window Size. 

• To select an area to be previewed at the project’s resolution 
setting, choose Selected Full Size. 

If you choose to select a portion of the Camera view, an instruction 
appears in the menu bar, as shown in Figure 6.3. Otherwise, no 
further action is required (see the paragraph following Figure 6.5).

Figure 6.3   Instruction in menu bar
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2. To complete the operation, drag a rectangle around the area of 
the Camera view you want to preview, as shown in Figure 6.4.

To cancel the operation, use the menu bar instruction as you 
would a menu and choose Terminate Operation, as shown in 
Figure 6.5.

While the image is rendering, the Camera icon will flash in yellow. 
Then, when the rendering is completed, the image will be displayed in 
a floating window within ElectricImage.

w
This preview window is the same window described in the section 
“The Display Command” (page 6-2).

Figure 6.4   Camera View window with preview frame selection

Figure 6.5   Canceling the operation
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Display Location
It is now possible to set a preference for where ElectricImage will 
display an image after it is rendered by the Camera application.

To set your display location preferences:

1. Choose Preview/Render… from the Edit menu.

A dialog box, as shown in Figure 6.6, opens.

2. Choose an option from the Display Image in pop-up menu:

• Projector (the default) launches Projector after Camera 
renders the image.

• ElectricImage quits the program after Camera renders the 
image.

• None returns to ElectricImage after Camera renders the 
image. You can then use the Display command (page 6-2).

3. To display an image immediately after it is rendered, enable the 
Display Image automatically check box.

4. To save the preferences, click OK or press Return.

w
To reset the system’s default preferences at any time, choose 
Default Preferences from the Edit menu.

Figure 6.6   Preview/Render Preferences dialog box
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Chapter 7 Vibe

For ElectricImage Scholastic Version, three options have been added 
to the Fill pop-up menu in the Project window toolbar:

• Randomize adds random numbers to selected data cells.

• Spring impresses a complex waveform on selected data cells.

• Jolt impresses an impulse across a range of selected data cells.

Collectively these three features are known as “Vibe.”

�
Contents

Randomize ...................................................................................... 7-4

Spring .............................................................................................. 7-5

Jolt.................................................................................................... 7-7
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Randomize
To add random numbers to selected data cells:

Choose Randomize from the Fill pop-up menu in the Project 
window’s tool bar.

A dialog box, as shown in Figure 7.1, opens.

Random Range This edit box contains a +/- value. Therefore, 5 would yield random 
numbers between -5 and +5. These numbers are added to the current 
value of each highlighted data cell.

Seed This edit box contains an initialization value for the random number 
generator. If you find patterns in the random numbers applied, you 
can alter the seed to improve the randomization.

Relative This check box, when enabled, causes the Random Range value to 
become a percentage value. The current value of each highlighted 
data cell will be increased or decreased by a random percentage.

Figure 7.1   Randomize dialog box
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Spring
To impress a complex waveform on selected data cells:

Choose Spring from the Fill pop-up menu in the Project window’s 
tool bar.

A dialog box, as shown in Figure 7.2, opens.

�
Because this command adds and subtracts from the current value of 
the data cell, multiple applications of Spring can be used with different 

�
frequencies and amplitudes to create “white noise.”

Figure 7.2   Spring dialog box

Attack Interval Bar Curve Window Decay Interval Bar
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Amplitude This edit box contains a value that controls the maximum and 
minimum points on the waveform.

Frequency This edit box contains a value that controls the number of complete 
cycles in the entire waveform.

Phase This edit box contains a value that shifts the starting point of the 
waveform. Phase may also be changed interactively by dragging the 
waveform in the curve window.

Relative This check box, when enabled, allows the amplitude to be treated as 
a percentage. At the maximum point on the waveform, the value of 
the data cell will be increased by the percent entered in the 
Amplitude edit box.

Reverse This check box, when enabled, inverts the entire waveform.

Decay This edit box contains a value that controls the slope of the 
waveform from the Decay Interval Bar to the end of the curve.

Decay Interval This edit box contains a value that controls the length of the decay. 
The decay interval may also be changed interactively by dragging the 
Decay Interval Bar in the curve window.

Attack This edit box contains a value that controls the slope of the 
waveform from its beginning to the Attack Interval Bar.

Attack Interval This edit box contains a value that controls the length of the attack. 
The attack interval may also be changed interactively by dragging the 
Attack Interval Bar in the curve window.
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Jolt
To impress an impulse across a selected range of data cells:

Choose Jolt from the Fill pop-up menu in the Project window’s tool 
bar.

A dialog box, as shown in Figure 7.3, opens.

�
This command could be used to simulate a camera hitting a small 

�
bump as it rolls along a track.

Amplitude This edit box contains a value that controls the maximum and 
minimum points on the waveform.

Frequency This edit box contains a value that controls the number of complete 
cycles in the entire waveform.

Decay This edit box contains a value that controls the slope of the entire 
waveform.

Figure 7.3   The Jolt Dialog Box
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Relative This check box, when enabled, allows the amplitude to be treated as 
a percentage. At the maximum point on the waveform, the value of 
the data cell will be increased by the percent entered in the 
Amplitude edit box.

Reverse The check box, when enabled, inverts the entire waveform.
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Chapter 8 Plug-Ins

There are two new plug-ins for ElectricImage Version 2.5, available 
from either the Object palette or the File menu:

• Dicer divides groups into smaller polygons to produce better 
results when applying deformations.

• Mr. Blobby forms spheres, or blobs, out of the groups that are 
linked to it.

Contents

Dicer................................................................................................. 8-2

Dicer Controls  8-3

Mr. Blobby....................................................................................... 8-4

Mr. Blobby Controls  8-5

Usage Notes  8-8
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Dicer
This plug-in increases the polygon density of any group or groups 
attached to it. That is, the number of polygons in the group is 
increased by dividing (or dicing) the group into small polygons. Dicer 
is therefore very useful when combined with Deformations, because 
groups that contain few polygons and vertices cannot be deformed.

To use the Dicer plug-in:

1. Click the Dicer icon in the Object Palette, or choose Add> then 
Dicer… from the File menu.

A dialog box, as shown in Figure 8.1, opens.

2. Use the controls of the dialog box to configure the operation to 
your preferences. For an explanation of these controls, refer to 
the section “Dicer Controls” (page 8-3).

3. Either click OK or press Return.

The Dicer effect is added to the project as a group.

4. Link the group(s) to be diced to the Dicer group.

5. To deform the group(s), apply the deformation to the Dicer 
group.

Figure 8.1   Dicer dialog box
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Dicer Controls

Segment Count This radio button option, the default setting, divides a group into 
equal length segments. The length of each segment is determined by 
taking the longest extent dimension (x, y or z) of the group and 
dividing it by the value in the Segment Count edit box.

Segment Length This radio button option, when selected, divides a group into 
segments whose length is determined by the value in the Segment 
Length edit box.

Triangulate This check box option, when enabled, uses triangles only (no 
quadrangles). Use this option if you notice flashing polygons in 
objects linked to Dicer.

Local Coordinates This radio button option, the default setting, determines the length 
of each segment by the local coordinates of the group as displayed in 
the Group Info Window.

Global Coordinates This radio button option, when selected, determines the length of 
each segment by the global coordinates of the group. These can be 
seen by turning on the rulers in the Top, Front, or Side View 
windows.
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Mr. Blobby
This tool takes groups that are linked to it and forms spheres (or blobs). 
As multiple blobs get close together, they blend into a single blob.

To use the Mr. Blobby plug-in:

1. Click the Mr. Blobby icon in the Object Palette, or choose Add> 
then Mr. Blobby… from the File menu.

A dialog box, as shown in Figure 8.2, opens.

2. Use the controls of the dialog box to configure the operation to 
your preferences. For an explanation of these controls, refer to 
the section “Mr. Blobby Controls” (page 8-5).

3. Either click OK or press Return.

The Mr.Blobby™ effect is added to the project as a group.

4. Link the group(s) to be affected to the Mr. Blobby group.

Figure 8.2   Mr. Blobby dialog box
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Mr. Blobby Controls

Texture Map Each Blob Allows a single texture map to be applied to every blob. Every blob 
will receive the same map.

Texture Map Whole
Model

Allows a single texture map to be applied to the extent of the entire 
Mr. Blobby group.

Mesh with Cubes Creates 4 sided polygons. 

Mesh with Tetrahedrons Creates 3 sided triangles. 

Interpolate Color: RGB When working with blobs of different colors this setting will blend 
the colors based on the RGB color model. There is a direct blend from 
one color to the next with no transitional hues. A blend from Red to 
Blue would look like mixed paint creating a smooth gradation 
between the two colors.

Interpolate Color: HSV When working with blobs of different colors this setting will blend 
the colors based on the HSV color model. This causes a blend from 
one color to the next with extra transitional hues appearing. The 
extra hues are created by interpolating through the Hue color 
spectrum when blending between a start and finish color. A blend 
from Red to Blue would look like a rainbow of Red, Orange, Yellow, 
Green, Cyan and Blue

Generate: Sphere This is a primitive to be used to set up a texture map. 

Select this option, then use the texture window to map the 
Mr. Blobby group. Only a spherical map will work. The map can be 
RGBA for bump mapping or transparency mapping. When done 
setting the map change Generate: Sphere to Generate: Groups Blobs, 
or Generate: Facet Blobs. When rendered each blob will appear with 
the texture map applied.

Generate: Torus This setting puts Mr. Blobby into a special mode in which only a 
torus will be created. No other Mr. Blobby functions will work.

Generate: Three Spheres This setting puts Mr. Blobby into a special mode in which only three 
spheres will be created. No other Mr. Blobby functions will work.
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Generate: Group Blobs This setting will take each group linked to the Mr. Blobby plug-in and 
make it a blob. It uses the bounding box size to determine blob size. 
This option allows you to control the movement of each individual 
blob by first animating a set of placeholder groups and then linking 
them to the Mr. Blobby group. This option also allows you to control 
the size of individual blobs by letting you animate the Scale of each 
placeholder group. This option also allows you to control the color of 
individual blobs by letting you animate the Color of each 
placeholder group.

Generate: Vertex Blobs This setting will take each vertex of a group linked to the Mr. Blobby 
plug-in and make it a blob. If you use a model, it will place a blob at 
each vertex of the model.If you use a particle generator, it will place a 
blob at each vertex emitted by the generator.The size of each vertex 
blob is set with the Vertex Blob Size entry box.The color of the vertex 
blobs are set with the surface color settings for the particle system 
group. If you want to use the color boxes inside the particle system 
plug-in to change blob colors over time, you must use the Generate: 
Facet Blobs option.

Generate: Facet Blobs This setting will take each polygon of a group linked to the 
Mr. Blobby plug-in and make it a blob. If you use a model, it will 
substitute a blob for each polygon of the model.If you use a particle 
generator, it will place a blob at each vertex emitted by the generator. 
If you use Mr. Nitro™, it will substitute a blob for each fragment 
generated by Mr. Nitro™. The size of each facet blob is based on a 
combination of the size of the facets in the model, and the setting in 
the Facet Blob Scale entry box.The color of the facet blobs are based 
on the original model, or set with the surface color settings in the 
group info window, or based on colors set in the Mr. Nitro™ or 
Particle plug-ins, or based on a texture map applied to the Mr. Blobby 
group.

Blob Threshold Affects how attractive the blobs are to each other. A higher value will 
cause multiple blobs to join.

Vertex Blob Size This sets the size of the blobs using World Coordinate units. All 
vertex blobs are the same size.
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Facet Blob Scale This sets the size of the blob as a percentage of the size of the polygon 
the blob is based on. A setting of 1 will create a blob that will totally 
encompass the bounding area of the polygon. (1 is equal to 100% of 
bounding area.) A setting of .5 will create a blob half the size of the 
total bounding region. A model with facets of differing sizes will 
produce blobs of differing sizes.

Mesh Resolution: EI This sets the resolution of the surface mesh for display within EI. A 
setting of 3 to 5 will create a usable mesh for setting up animation.Be 
careful to test the effects of a higher Mesh Resolution. If you are 
working to get a specific look, be aware that the shape of the surface 
will change when you render at higher resolution.

Mesh Resolution:
Camera

This sets the resolution of the surface mesh for rendering within 
Camera. A setting of 15 to 20 will create a fairly tight surface.
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Usage Notes

• All blobs are spherical. You cannot make them ellipsoidal, and 
you cannot change their region of influence on an individual 
basis.

• In order for blobs to react to each other they must be generated 
by the same Mr. Blobby group.

• Mr. Blobby settings do not animate and do not set keyframes.

• Blobs do not understand rotation, as such it does no good to 
animate the rotation of Group Blobs because the blob won't pick 
up the rotation angles.

• Blob size is based on the bounding box size. If you rotate a group 
it's bounding box is likely to change size resulting in a blob that 
grows and shrinks

• Plug-ins pass their data down the project hierarchy. Try linking a 
standard shape to a Mr. Nitro™ and then link that Mr. Nitro™ to 
a Mr. Blobby (in Generate: Facet Blobs mode). As the standard 
shape explodes, Mr. Blobby will convert the fragments into blobs.

• The blobs are recreated at every frame. Large numbers of blobs 
(such as those created by Mr. Nitro™ or a Particle System) may 
add huge numbers of polygons to your project. Remember, a 
single facet created in a Mr. Nitro™ explosion might be turned 
into 200 polygons by Mr. Blobby.
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Chapter 9 Gamma Control

Gamma is a technical term used to describe the intensity of different 
levels of gray as they appear on a computer monitor or on a video 
screen.

ElectricImage provides control over Input Gamma and Output 
Gamma.

�
Contents

Overview ......................................................................................... 9-4
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Gamma Controls in ElectricImage .............................................. 9-6
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Overview
Computers typically use values from 0 to 255 to represent gray values 
from black to white. You may expect that a value of 128 would be 
displayed as a 50% gray value precisely between black and white. 
Because of the way electrons illuminate the phosphors on a computer 
screen, however, this is not the case.

The actual pixel intensity value is calculated with the formula:

x ^ g

where x is the gray value divided by 255 and g is the monitor’s 
gamma value.

A typical monitor has a gamma value of between 1.4 and 1.6. 
Standard NTSC video gamma is 2.2. For a pixel with a value of 128, 
the intensity would be:

(128/255) ^ 2.2, or about 20% illumination
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Setting Gamma
ElectricImage’s default settings for Input and Output Gamma are 
identical. Changing the Input Gamma to a new value will cause the 
Output Gamma to be set to the new value as well.

�
It is to your advantage to keep the Input and Output Gamma settings 
equal. If you use one value for Input Gamma and a different value for 
Output Gamma, ElectricImage will remap RGB and alpha channels 
from the Input to the Output gamma settings. Since there are only 255 
values for each channel, some colors may be lost. This may be 

�
noticeable in areas of smooth gradation of color.

Ideally, your texture and other maps should be created at the same 
gamma setting as that required for your output medium. For video 
the setting is 2.2, for multimedia 1.4, and for film it will depend on 
the input gamma of your film recorder.

You should begin by setting your computer monitor’s gamma to the 
gamma of your target medium. The Macintosh provides some control 
over gamma, as follows:

1. Open the Monitors control panel.

2. Hold down the Option key while clicking the Options… button.

3. Choose either:

Mac Std Gamma (1.4)

or

Uncorrected Gamma (2.2).

�
If you need a different value (for a film recorder or other custom 
output device), you will need to purchase a separate application to 

�
set your gamma.
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Gamma Controls in ElectricImage
To set Input Gamma:

1. Choose Preview/Render… from the Edit menu.

The Preview/Render dialog box, as shown in Figure 9.1, opens.

2. Use the Input Gamma edit box (at the bottom) to set the Input 
Gamma value (which defaults to 1.0).

�
The Input Gamma is a preference, and as such is stored in the 
ElectricImage preferences file. To reset the system’s default 
preferences at any time, choose Default Preferences from the Edit 

�
menu.

Figure 9.1   Preview/Render Preferences dialog box 
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To set Output Gamma:

1. Choose Render from the File menu.

The Render Control window, as shown in Figure 9.2, opens.

2. Use the Output Gamma edit box (at lower left) to set the 
Output Gamma value (which defaults to 1.0).

Figure 9.2   Render Control window
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The commands in the Select menu allow you to select (that is, 
highlight) objects in the World View and Project windows. They 
include:

• The All, Find, and Find Again commands.

• Alternate commands are also available when the Option key is 
held down. All of the commands are described on the following 
pages.
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Overview

•

Figure 10.1   The Select Menu (at left) and Select Menu with Option Key (at right)
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All
This command selects all cameras, lights and model groups in the 
current project.

�
Objects that are locked cannot be selected with this command. Objects 
are locked (or unlocked) in the Project window, as discussed in the 
section “The Object Status Panel” (page 8-17) in Chapter 8: The Project 

�
Window

Find…
This command is used to locate and select objects in the project.

To find an object:

1. Choose Find… from the Edit menu.

A dialog box, as shown in Figure 10.2, opens.

2. Type the name of the object or a search string.

3. Specify whether or not the search string is a whole word (the 
default) and whether or not to match the case of the letters.

4. Specify a wildcard character and click Use Wildcard

5. Either click Find or press Return.

Figure 10.2   Dialog box used to find an object
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The Select Menu Commands
The table below lists the commands available from the Select menu.

Command Description

All Selects all unlocked objects (same as previous Edit 
menu command).

None Deselects all selected objects.

Inverse Deselects all selected objects while selecting all 
other objects that are not locked.

Find Opens a dialog box to enter a search string (same 
as previous Edit menu command). Wildcards may 
now be used to control the search. Selects the 
first object that matches the search string.

Find Again Selects next object matching the search string 
previously entered with the Find command (same 
as previous Edit menu command).

Find All... Similar to the Find command except that all 
objects matching the search string are selected.

Visible Selects all objects with visibility check boxes on.

Locked Selects all objects with lock check boxes on.

Hidden Selects all objects hidden in the Project window.

Camera Selects the Camera.

Lights Selects all lights.

Groups Selects all groups.

Effectors Selects all effectors. For a description of effectors, 
refer to Chapter 3: Effectors.

Model Opens a submenu to select a model (same as 
previous Model List menu).

Parent of Selected Selects the immediate parent of the currently 
selected object.

Children of Selected Selects the immediate children of the currently 
selected object.
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Choosing the Select menu while the Option key is held down reveals 
several alternate commands, listed in the table below.

Command Description

All + Locked Selects every object in the project.

Ancestors of Selected Selects all parents up the hierarchy.

Offspring of Selected Selects all children down the hierarchy.
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Chapter 11 Value Modification System

A simple system has been implemented in ElectricImage to allow 
relative and percentage changes to be entered into the Project 
window cells, and into the edit boxes of most modal and non-modal 
windows.

�
Contents
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Implementing Value Changes
There are two types of value changes:

• Relative Offset value changes alter each selected item by adding, 
subtracting, multiplying, dividing, or taking to a power. A change 
of +25 would add 25 to the current value regardless of what it is. 

• Percentage value changes alter the selected item by computing a 
specified percentage to each value individually. A percentage 
change of 150% would make the value 1.5 times its current 
value, and a percentage change of 75% would make the value 3/4 
of its current value. 

Relative offset and percentage changes are implemented by entering 
formulas in data cells or edit boxes. The syntax of a formula is:

@ symbol amount

where @ means the current value of the cell, symbol indicates an 
operation to be performed, and amount is the numeric offset or 
percentage. Therefore, @*7.6 means: take the cell’s “current value” 
and multiply it by seven-point-six.

�
Cells and edit boxes do not remember the formulas. The new value will 

�
be computed and immediately written into memory over the old value. 

Table 11.1 shows the symbols that are supported:

Table 11.1  Supported symbols

Symbol Action

+ add

- subtract

* multiply

/ divide

^ exponential

% percentage
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Table 11.2 provides examples of formulas for relative offset changes.

Table 11.3 provides examples of formulas for percentage changes.

Figure 11.2  Examples of formulas for 
offset changes

Formula Result

@+2.7 Adds 2.7 to the channel.

@-2.7 Subtracts 2.7 from the channel.

@*2.7 Multiplies the channel by 2.7.

@2.7 Also multiplies the channel by 2.7.

@/2.7 Divides the channel by 2.7.

@^2.7 Takes the channel to the power of 2.7.

Figure 11.3  Examples of formulas for 
percentage changes

Formula Result

@2.7% Makes the channel 2.7 percent of its current value.

@*2.7% Also makes the channel 2.7 percent of its current value.

@/2.7% Divides the channel by 0.027.

@+2.7% Adds 2.7 percent to the channel.

@-2.7% Subtracts 2.7 percent from channel.

@^2.7% Undefined. Gets treated as @*2.7
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Usage Tip
Assume that you have a whole series of custom frames that control 
the intensity of a light. You have used custom frames because you 
wanted the light to flicker over time. How do you increase the 
intensity by 20% over the duration of the animation without 
changing the value in every cell by hand?

Follow this procedure:

1. Set the Project window to Keyframe mode.

2. Highlight the range of intensity cells that you wish to change.

3. Choose the Fill Constant... command from the Project 
window’s toolbar.

4. Type @+20% into the dialog box that appears.

5. Click OK.

The value of every selected cell has just been increased by 20%.
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Chapter 12 Multi-Frame Model Export

ElectricImage Version 2.5 features a multi-frame model export 
feature, for exporting models in a variety of file formats.

This feature works in the same manner as the File menu’s Save 
Model command, except that a range of frames can be specified, 
producing multiple versions of the model, with each version 
identified by the frame number from which it was exported.

Contents

Exporting Models......................................................................... 12-2
ElectricImage™ Version 2.5 Supplement 12-1



Chapter 12: Multi-Frame Model Export

2.5Book  Page 2  Wednesday, August 16, 2000  12:01 PM
Exporting Models
To export multiple copies of a model over a range of frames:

1. Hold down the Option key and choose Save Model in Frame 
Range…> then FACT… (or Other…) from the File menu.

The dialog box used to set the model’s hierarchy opens (as happens 
with the basic Save Model command).

2. Specify whether or not you want to preserve the model’s 
hierarchical structure by clicking the appropriate radio button.

Another dialog box, as shown in Figure 12.1, opens.

3. Enter the starting and ending numbers for the frame range in 
the Start and Stop edit boxes.

Note: The Reverse button will have no effect.

4. Click OK or press Return.

Another dialog box opens for naming and placing the copies of the 
models.

5. Name the model (and set other options as appropriate), then 
click Save or press Return.

The model(s) are saved in separate files with filenames that add the 
frame number to the end of the given name.

Figure 12.1   Dialog box used to enter a frame range
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Chapter 13 ImageOMFI

This standalone application converts Image stills and animations 
into Avid Technology’s Open Media Framework Interchange format.

w
The current version of the OMFI specification is 1.5. Version 1.5 does 
not support an alpha channel—therefore, ImageOMFI premultiplies the 
alpha channel before converting each frame.

Use of ImageOMFI is similar to that of the ImageQT application that 
was included in Version 2.0.
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Chapter 14 Renderama™

Renderama™ is an application program designed to maximize the 
rendering utilization of your computer hardware. Renderama can be 
used to schedule batch rendering on a single computer, as well as to 
distribute rendering jobs among many networked computers. Jobs 
can be distributed across AppleTalk and TCP/IP local area networks as 
well as across TCP/IP wide area networks such as the global Internet. 
Additionally, Renderama can distribute rendering jobs transparently 
among multiple computer platforms including Macintosh and 
UNIX-based computers.

Renderama acts as a middle-man in-between ElectricImage and one 
or more Camera rendering engines. It coordinates all rendering 
activity, automatically distributing jobs across the network, or, in the 
case of a single machine configuration, queuing several jobs for 
subsequent batch rendering.

Contents

Installing Renderama.................................................................. 14-2

Configuring Renderama ............................................................. 14-2

Using Renderama....................................................................... 14-21

Renderama Glossary.................................................................. 14-32
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Installing Renderama
Renderama is a small (500 KB) application. We recommend installing 
it in the Startup Items folder (in the System folder) of all Macintosh 
computers that will be using ElectricImage or Camera.

w
It is to your advantage to launch Renderama before ElectricImage. 
Otherwise, there may not be enough contiguous memory to launch 
Camera with its maximum memory setting.

Configuring Renderama
Before Renderama can be used for distributed or batch rendering, it 
must be configured correctly. Configuring Renderama is simply a 
matter of setting a few options in the Preferences window. However, 
since there are seven different modes in which Renderama can be 
configured, some explanation is necessary.

Modes of Operation

Renderama can be configured to run in several different modes. This 
allows a single application to meet many different needs. There are 
four distinct Renderama modes:

• User

• Server

• Slave

• Standalone

Additionally, Renderama can run in any combination of User, Server, 
and Slave modes, giving a total of seven unique modes in which 
Renderama can be configured. The table on the next page 
summarizes each possible configuration.
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The current mode is configured using the Preferences window. 
Renderama’s Preferences window is described in the section “The 
Preferences Window” (page 14-10).

Mode User Server Slave Standalone

User Mode

• initiate rendering jobs
• display finished jobs

Server Mode

• maintain job queue, distribute files
• monitor slaves, assemble frames

Slave Mode

• perform rendering
• retrieve needed files for Camera

Standalone Mode

• maintain local job queue to allow 
batch rendering.

User + Server Mode

• initiate jobs, maintain job queue
• distribute files, assemble frames

Server + Slave Mode

• maintain job queue, distribute files
• perform rendering, assemble 

frames

User + Server + Slave Mode

• initiate jobs, maintain queue
• perform rendering, assemble 

frames

User + Slave Mode

• initiate rendering jobs
• perform rendering
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User Mode This mode includes the features needed by animators using 
ElectricImage to take advantage of distributed network rendering. 
User mode requires the animator to choose a network render server 
in the Renderama Preferences window. If Renderama is configured in 
Server mode in addition to User mode, then the local machine can 
act as its own render server.

When the user initiates a rendering job within ElectricImage, an 
animation control file will be created by ElectricImage, then sent by 
Renderama to the currently chosen render server. The render server 
will determine if it has up-to-date copies of the model, texture map, 
and plug-in files needed to render the job. If any of the server’s files 
are out-of-date, the render server will immediately collect the needed 
files from the animation machine.

Once the render server has up-to-date versions of the job’s model, 
map, and plug-in files, the job will be entered into the server’s job 
queue and will be distributed to slave rendering machines as they 
become available. At this point, the animation machine that 
submitted the job may be shut down or disconnected from the 
network without affecting the rendering job’s progress (unless the 
machine is acting as its own render server). This allows animators 
who submit rendering jobs over a dial-up connection such as Apple 
Remote Access, SLIP, or PPP to disconnect once the render server has 
finished collecting the job’s associated files.

Server Mode This mode takes care of several tasks involved in distributed network 
rendering. A computer configured to be a render server maintains a 
local job queue. As new rendering jobs are accepted by the server 
they are added to the end of the queue. It is the render server’s 
responsibility to collect up-to-date copies of all model, texture map, 
and plug-in files when it accepts a new job from a user. Only files that 
have been modified since the last rendering job are collected.

Additionally, the render server keeps track of all slave machines on 
the network. It divides up rendering jobs beginning with those at the 
head of its queue, and distributes rendering tasks to each available 
slave renderer. Slaves request model, map, and plug-in files from the 
render server as they need them. The render server responds to the 
slave’s requests by forwarding files to the slave machines as needed.
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As slave machines complete their rendering tasks, the render server 
retrieves the finished frames from the slave machines and assembles 
them into a complete animation for each job. Finally, once a 
rendering job has been completed, the render server checks to see if 
the user machine that submitted the job is still connected to the 
network, and if so sends the finished animation file to the user 
machine.

Slave Mode This mode handles the tasks necessary to perform unattended 
rendering on a dedicated network rendering machine. When a render 
slave becomes available to perform network rendering, it notifies all 
render servers on the network that it is currently idle and ready for a 
new task. As a render slave receives rendering tasks from a server, it 
launches the ElectricImage Camera rendering engine to render each 
incoming task. Renderama takes care of retrieving the files needed by 
Camera to render the task. Finally, Renderama sends finished frames 
back across the network when requested to do so by a render server.

Standalone Mode This mode is designed specifically for single-machine batch 
rendering. When operating in Standalone mode, Renderama ignores 
all other Renderama nodes on the network. In fact, no network is 
necessary to use Renderama in Standalone mode.

Standalone mode allows an animator to submit several rendering 
jobs to be rendered at a later time. As jobs are submitted, Renderama 
adds them to its local job queue in a suspended state. Once the 
animator has batched up the jobs they want to render, they can use 
Renderama to release the jobs in the queue for local rendering by 
ElectricImage Camera.
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Typical Configurations

Along with the flexibility provided by Renderama’s different modes 
of operation comes a fair degree of complexity. Typically the most 
difficult decision to be made when using Renderama is determining 
which of the seven possible configuration modes to use. To help you 
make this decision, here are some of the more common 
configurations.

Renderama Solo For animators with access to a single machine, this mode 
(Figure 14.1) allows rendering of multiple jobs overnight.

Animators with access to a network rendering system may wish to 
submit several jobs to be rendered over the network using Renderama 
in User mode, then switch Renderama into Standalone mode and 
submit several more jobs for local rendering before going home for 
the evening. Switching Renderama’s modes is as simple as clicking a 
check box in the Renderama Preferences window.

The Small Render Farm When the number of slave rendering machines is small (Figure 14.2), 
the need for a dedicated render server is low, so animators can 
configure their machines to act as both users and render servers.

Each animator’s machine maintains its own job queue and takes care 
of distributing model, texture map, and plug-in files to each slave 

Figure 14.1   Standalone mode

Figure 14.2   Small User + Server mode network

Users/Servers

Slaves
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machine. Slaves accept tasks from animation machines on a 
round-robin basis.

The Growing Farm As the number of slave rendering machines increases (Figure 14.3), 
the file transferring load on each animation machine increases. This 
is because it is necessary for the animation machines to send model, 
texture map, and plug-in files to each slave machine that is rendering 
one of its jobs.

Additionally, the animation machines are responsible for collecting 
the finished frames from the slaves and assembling them into a 
finished animation for each job. This added load can make it difficult 
for an animator to continue to work interactively with their 
computer. This is when a dedicated render server becomes a valuable 
addition to the network.

A Dedicated Server Adding a dedicated render server to the network (Figure 14.4) reduces 
the load on each animation machine.

Figure 14.3   Large User + Server mode network

Users/Servers

Slaves

Figure 14.4   Network with dedicated server

Server

Slaves

Users
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Animation machines no longer need to send model, map, and 
plug-in files to each slave, instead they send the files once to the 
render server. Additionally, the render server takes care of 
maintaining the queue of jobs to be rendered over the network and 
also collects and assembles finished frames into complete animations 
before sending them to the animation machines. Unlike animation 
and slave machines, dedicated render servers typically do not need 
powerful CPUs or floating-point processors. A fast hard-disk and 
network connection are generally more beneficial to a dedicated 
render server than a powerful CPU. 

An Overloaded Server As a distributed rendering network grows, it is possible to overload a 
dedicated render server with too many animation and slave 
machines (Figure 14.5). When this occurs it is time to add another 
dedicated render server.

w
The diagram in Figure 14.5 is not meant to suggest the exact size of a 
network that can overload a dedicated server. This will depend on the 
speed of the server and network as well as the demand placed on the 
server by the animation machines.

Figure 14.5   Overloaded server

Server

Slaves

Users
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Multiple Dedicated
Servers

In this scenario, the load supplied by the animation machines is 
divided among two render servers (Figure 14.6).

Notice however that each render server can still have access to all of 
the available slave machines. This allows maximum utilization of the 
slave machines, even when one of the render server’s job queue 
becomes empty.

Figure 14.6   Multiple dedicated servers

Servers
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The Preferences Window

Renderama is configured through its Preferences window 
(Figure 14.7), which is accessible from the File menu.

The Preferences window is used to specify in which of the seven 
possible modes Renderama will operate. Additionally, the Preferences 
window is used to specify options that apply specifically to User and 
Server mode.

When the Preferences window is opened, it initially displays 
Renderama’s current configuration. A pop-up menu at the top of the 
dialog allows you to switch between the Configuration, User, and 
Server Options areas of the Preferences dialog.

Figure 14.7   Preferences window with Configuration options
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Configuration Options Renderama’s Configuration Options specify how Renderama will 
operate on the local machine and how it will connect with other 
machines over the network. In Figure 1.7 (page 14-10), Renderama is 
configured to operate in User and Server modes. Additionally it is 
configured to connect with all Renderama nodes in the “EI Ethernet” 
zone via AppleTalk. For incoming connections to computers using 
the TCP/IP network protocol, Renderama is configured to listen for 
connections on the local TCP port 5000. A password has been 
specified to prevent unauthorized access to Renderama over TCP/IP 
wide-area networks.

The most important step in configuring Renderama is choosing the 
appropriate configuration mode for the local machine. For more 
information on choosing the local configuration mode, read the 
section “Modes of Operation” (page 14-2). The four check boxes 
along the left side of the dialog box determine Renderama’s current 
configuration.

AppleTalk Networking

This check box in the upper right allows you to determine whether 
Renderama will attempt to automatically connect to other 
Renderama nodes using AppleTalk networking.

AppleTalk Zones

This list in the upper right corner of the Preferences dialog allows you 
to select one or more AppleTalk zones to be automatically searched 
for active Renderama nodes. This list will contain all zones in your 
AppleTalk local area network. By clicking once on a zone in the list 
you can enable or disable it for use by Renderama. Initially only the 
zone to which your Macintosh belongs will enabled. The zones that 
are enabled for use by Renderama are preceded by a bullet (•).

TCP/IP Networking

This check box allows you to connect to remote TCP/IP hosts 
running Renderama. Unlike AppleTalk networking, Renderama can 
not automatically detect other Renderama nodes running on a 
TCP/IP network. Therefore it is necessary for you to explicitly enter 
the network identity of each remote TCP/IP machine you wish your 
local Renderama to connect with. Likewise, remote Renderama’s 
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must be told your local TCP/IP identity to initiate a connection with 
your machine. See the section “Networking Options” (page 14-17) for 
more information on how to enter the TCP/IP identity of a remote 
machine.

Local TCP Port

This edit box allows you to specify which TCP port to use locally to 
listen for incoming TCP/IP connections. This value must be an 
integer number between 0 and 65,535. It must be chosen to avoid a 
collision with other TCP/IP-based programs running locally that 
might be using the same port number.

Generally it is preferable to choose a higher number since port 
numbers in the lower range are reserved for standard TCP/IP 
programs such as Telnet, FTP, etc. The number 5000 was chosen as an 
arbitrary default port number. Unless you are aware of another 
program on your local Macintosh that uses TCP port 5000, you are 
probably safe with this default value.

Local Password

This edit box allows you to specify a password that remote TCP/IP 
nodes must provide in order to establish a connection with your local 
machine. In order to establish a TCP/IP connection with a remote 
machine running Renderama, you must know three pieces of 
information: 1. the remote machine’s Internet address, 2. the TCP 
port number Renderama is using on the remote machine, and 3. the 
password specified in the remote machine’s “Local Password”.
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User Options The User Options area of the Preferences window (Figure 14.8) allows 
you to control how rendering jobs initiated from ElectricImage on 
the local machine are handled.

Render Server

This list toward the top of the dialog box allows you choose which 
render server will receive the jobs you submit. A render server is any 
machine currently running Renderama in Server mode. If you are 
running Renderama locally in Server mode, then typically you will 
choose your own local machine as your server. However, to reduce 
the demands placed on your local machine you may instead want to 
choose a remote render server. Click once on the icon of your desired 
render server. Clicking twice on a render server icon will choose the 
server and dismiss the Preferences dialog as if you clicked the “OK” 
button.

Figure 14.8   Preferences window with User options
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Finished Frames

This radio button group allows you to determine how rendered 
frames will be handled once they are completed by a slave renderer.

• If the Remain on Slave Machines button is selected, then the 
Image files for the pieces of your animation will not be collected 
and assembled into a complete animation. Instead they will be 
left in a special work folder created for you on the slave machine 
on which they were rendered.

A textual report will be created and sent to you when the job has 
finished rendering listing the name and location of each Image 
file that was created to render your job.

This option is useful when a finished animation is so large that it 
is impractical to send it across the network.

• In most cases you will want to select the Assembled into 
Complete Animation radio button instead.

With this option, the finished frames are transferred from the 
slave machines on which they were rendered to the render server. 
The render server takes care of assembling the separate Image 
files into a single animation file, and then sends the final 
animation to the machine that originated the job.

Display an alert box when jobs are completed

This check box allows you to specify whether or not Renderama 
should notify you when finished render jobs arrive.

Launch Projector when jobs are completed

This check box allows you to specify whether Projector should be 
automatically launched when a finished job is received locally. If the 
check box is unchecked, then Projector will not be launched.

Automatically open finished animation

This check box allows you to specify whether Projector should 
automatically open completed animations when it is auto-launched 
by Renderama. Generally you will want this box to be checked. 
However, if you typically use Projector to send animations out to tape 
instead of creating FastLoad files, then you may want to leave this 
box unchecked.
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Server Options The Server Options area of the Preferences window allows you to 
specify how Renderama behaves as a render server.

Rendering Distribution Method

This radio button group determines how rendering jobs are divided 
and distributed to the slave rendering machines.

• If the Adaptive Load Balancing radio button is selected, then 
the render server automatically divides jobs into tasks to match 
the abilities of each slave machine.

In other words, a more powerful slave rendering machine will be 
given a proportionally larger rendering task than a less powerful 
slave. The “power” of a slave machine is based on the average 
time it takes the slave to render a single frame of animation. This 
average time per frame is maintained by Renderama for each 
slave machine. Over time, as the machine is used to render many 
different jobs, this average becomes a reasonable indicator of the 

Figure 14.9   Preferences window with Server options
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machine’s overall rendering power. However, when Renderama is 
first installed on a network, it has no way to calculate a 
reasonable estimate of each slave machine’s rendering power. To 
handle this, there is an alternative distribution method that 
divides each job into fixed size tasks.

• If the Fixed Size Tasks radio button is selected, then rendering 
jobs are broken up into fixed size tasks. The number of frames in 
each task is determined by the number of active slave machines 
at the moment and the setting of the Rendering Task Size slider. 
If the slider is all the way to the right (Maximum Frames), then 
the size of each rendering task will be determined by dividing the 
size of the rendering job by the number of currently active slave 
machines.

In other words, if there are four slave machines, then each 
rendering jobs will be divided into four quarters. Setting the 
slider to Maximum Frames guarantees the least amount of 
division of jobs and therefore the least amount of overhead. 
However, if the all of the slave machines are not equal in 
rendering power, then rendering jobs may take longer to 
complete because weaker slave machines are given the same size 
tasks as the stronger slaves.

Rendering Task Size

To prevent a slow slave machine from stretching out the overall 
rendering time of each job, drag this slider toward the left. This will 
cause the render server to divide each render job into smaller tasks. If 
the slider is moved all the way to the left (Single Frame), then jobs 
are divided into the smallest possible tasks, currently one frame per 
task.

If your slave rendering machines are all of the same configuration 
(i.e. all PowerMac 8100/110s with 256 Mb of RAM), then you will 
want to keep the slider all the way to the right for the least possible 
overhead. On the other hand, if you have slave rendering machines 
of all different types, then you will have to experiment by moving 
the slider to the left until you find you are no longer routinely 
waiting on the slowest slave machine for your rendering jobs to 
complete.
14-16 ElectricImage  Animation System



Configuring Renderama

2.5Book  Page 17  Wednesday, August 16, 2000  12:01 PM
Networking Options The Networking Options area of the Preferences window 
(Figure 14.10) allows you to specify networking parameters for 
Renderama. Additionally you may create a list of remote TCP/IP host 
machines for Renderama to automatically initiate connections with 
when it starts running.

Incoming Message Queue Size

This edit box can be used to increase the number of incoming 
network messages Renderama can handle at once.

Typically you will not need to change this number from its default 
value of 400. However, for render servers that are connected to more 
than 10 slave machines it is a good idea to increase this value by 40 
for each additional slave machine.

In other words, if a render server is making connections to 12 slave 
renderers, then set this value to 480 messages. If a server typically 
connects to 20 slave machines, then set this value to 800 messages.

Figure 14.10   Preferences window with Networking options
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Increasing the incoming message queue size reserves extra space in 
memory for messages from remote machines. Each increment of 100 
messages requires approximately 3 Kb of memory. By allowing the 
user to set this value, Renderama is able to keep a small memory 
footprint on machines with lower network traffic, and scale up 
accordingly in situations where the network traffic is greater.

Network Timeout Duration

This edit box can be used to change the amount of time that 
Renderama will wait for a response from a remote machine.

If a remote machine is not responding promptly, there are typically 
three explanations:

• The remote machine is too busy to respond promptly.

• The network connection is slow.

• The remote machine has crashed without closing the 
connection.

In the first two situations, it is desirable to have a longer network 
timeout period to give responses from the remote machine time to 
arrive. However, if the remote machine has crashed, then you do not 
want to wait all day for a response that is never going to come. If you 
typically connect to a remote machine that has trouble responding 
promptly either because it is overloaded or the connection is slow, 
then you may want to increase Renderama’s network timeout 
duration.

Renderama will display the spinning watch cursor whenever it must 
wait more than 1 second for a response from a remote node. The 
cursor will spin until the response arrives or the network timeout 
duration expires. Additionally, you can type Command-period to 
immediately force Renderama to stop waiting for a response 
whenever you see the spinning watch cursor. However if Renderama 
fails to receive a response that is vital to the success of the job being 
processed, then the job may not complete successfully.
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Remote TCP/IP Hosts

This list on the right side of the Preferences window allows you to 
specify TCP host machines to which Renderama will attempt to 
initiate a connection each time it starts up. Renderama can not 
automatically detect remote Renderama nodes across a TCP/IP 
network as it can across an AppleTalk network due to differences in 
the way the networking protocols are implemented. Additionally, 
since the global Internet includes millions of computers around the 
world, it is not feasible to automatically search for remote nodes 
running Renderama. For these reasons you must explicitly enter the 
address and port number of each remote TCP/IP Renderama node.

To add a new TCP/IP host to the list, click the New… button just 
below the list. A window will open, as shown in Figure 14.11, 
allowing you to enter the address, port number, and password of a 
remote Renderama node.

• Remote Address

You may enter either a valid domain name or IP address in dot 
notation into this edit box.

Figure 14.11   Remote TCP/IP Host window
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• Remote TCP Port

In this edit box you must enter the TCP port number used by 
Renderama on the remote machine to listen for incoming 
connections.

• Remote Password

If a TCP/IP password has been entered in the Configuration 
Options area of the Preferences window of the remote host then 
you must enter the same password in this edit box. If you are 
unsure of these values, check with the user or system 
administrator of the remote host.

• Enabled

This check box specifies whether or not a connection will 
actually be initiated with the remote host.

In the list of remote TCP/IP hosts, enabled hosts will have a bullet (•) 
to the left of the host’s address and port number. To prevent 
Renderama from connecting to a TCP/IP node without actually 
removing the node from the list, click once on the node to disable it. 
A second click will enable it again. To permanently remove a node 
from the list, drag its entry into the small trash icon below the list. To 
change a node’s address, port number, or password, double-click on 
the node in the list.
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Using Renderama
In general, Renderama is designed to require as little user interaction 
as possible. Once configured, Renderama attempts to go about its 
business of performing distributed or batch rendering with little or 
no user intervention. However, Renderama provides feedback to the 
user indicating the progress of rendering jobs and allows you to 
abort, suspend, resume, or postpone rendering jobs on demand.

Figure 14.12 shows what a machine using Renderama in User and 
Server mode to render three jobs using three slave rendering 
machines might look like.

There are three types of Renderama windows: the Main window, the 
Machine Info windows, and the File Transfers window. All three types 
of windows are shown in Figure 14.12.

Figure 14.12   Renderama in use
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The Main Window

Renderama’s Main window is always open while Renderama is 
running. It includes information that pertains to the mode in which 
Renderama is configured, therefore the appearance of the Renderama 
Main window changes depending on the current mode.

User Mode In this mode, the Renderama Main window (Figure 14.13) displays 
the job queue of the currently chosen render server.

Jobs in the queue are processed from top to bottom, therefore the job 
at the top is the first candidate for rendering by available slave 
machines. In User mode, you can select any of the jobs that you 
submitted and have the render server abort, suspend, or resume the 
job by using the Job menu.

The small icon and message at the bottom of the window indicate 
whether the currently chosen render server is on-line or off-line. 
Additionally this area of the window is used to temporarily indicate 
file transferring activity.

Figure 14.13   Main window in User Mode
14-22 ElectricImage  Animation System



Using Renderama

2.5Book  Page 23  Wednesday, August 16, 2000  12:01 PM
Server Mode In this mode, the Main window (Figure 14.14) displays the server’s 
local job queue as well as a list of the slave machines available for 
rendering.

Any of the jobs in the job queue may be selected and acted upon by 
the Job menu. Additionally, the order of the jobs in the job queue 
may be changed by dragging selected jobs up or down in the queue.

The list of slave machines in the bottom half of the window shows 
the status of each slave renderer currently connected to the local 
server. A bullet (•) to the right of the slave’s status message indicates 
that Renderama is currently running on the slave machine. If no 
bullet appears, then the machine is configured to be a slave renderer, 
but Renderama is not currently running on the machine, therefore it 
is not currently available for slave rendering. To obtain more 
information about a slave machine, double-click on it to open the 
slave’s Machine Info window.

Figure 14.14   Main window in Server Mode
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If Renderama is running in both User and Server modes, and the 
currently chosen render server is a remote machine, then a situation 
arises in which there are two possible job queues to display in the 
Main window:

• The local server’s job queue

• The chosen server’s job queue

In this case, a pop-up menu appears above the job queue allowing 
you to switch between displaying the local job queue and the remote 
server’s job queue (Figure 14.15).

In practice this situation is quite common. Animators find that it is 
nice to see the status of the slave machines as they are rendering, so 
they frequently run Renderama in both User and Server mode. 
However they still wish to off load the file transferring 
responsibilities to a remote server, so they choose a remote render 
server instead of acting as their own server. One thing to keep in 
mind however is that running Renderama in Server mode increases 
the amount of network traffic that your machine will handle 
significantly. This is primarily due to status messages that slave 
machines send to all connected render servers. In addition, Server 
mode uses more RAM than User, Slave, or Standalone modes.

Figure 14.15   Main window in User + Server mode
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Slave Mode In this mode, the Main window (Figure 14.16) displays a message 
describing the task currently being rendered by the local slave. If 
Camera terminated abnormally the last time it was executed, the 
Main window’s message indicates why Camera terminated.

Standalone Mode In this mode, the Main window (Figure 14.17) displays the local job 
queue. Standalone mode is designed to provide local batch rendering 
for single-machine configurations. When running Renderama in 
Standalone mode, jobs are added to the job queue in a suspended 
state. This allows you to queue up several jobs locally before 
rendering actually begins. To begin rendering the jobs in the queue, 
select the jobs and choose “Resume” from the Job menu (page 14-31).

As with User and Server mode, jobs in the queue are processed from 
top to bottom. However, in Standalone mode the network is ignored 
and all rendering is performed by the local machine. You can select 
any of the jobs in the queue and abort, suspend, or resume them 
using the Job menu commands. Additionally, the order of the jobs in 
the job queue may be changed by dragging selected jobs up or down 
in the queue.

The message at the bottom of the window describes the task 
currently being rendered by the local slave.

Figure 14.16   Main window in Slave Mode

Figure 14.17   Main window in Standalone Mode
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The Machine Info Window

Double-clicking a slave machine in the Renderama Main window will 
open a Machine Info window, as shown in Figure 14.18, for that 
slave.

The Machine Info window displays information about the slave 
machine such as the available RAM and the currently mounted disk 
volumes. It also shows a preview of the last image to be rendered. 
Additionally, a button at the bottom of the Machine Info window 
allows you to remotely stop Renderama on the slave machine.

Figure 14.18   Machine Info window
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The File Transfers Window

Renderama’s File Transfers window (Figure 14.19) displays a list of all 
files currently being transferred over the network.

Renderama is capable of sending several files concurrently in the 
background. This allows processing by Renderama and other 
applications on the local machine to continue while Renderama is 
transferring files across the network.

Figure 14.19   File Transfers window
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Renderama’s Menus

The File Menu This menu has five commands.

• Preferences…

This command allows you to open Renderama’s Preferences 
window through which you can configure Renderama, as 
discussed in the section “Configuring Renderama” (page 14-2).

• Show File Transfers

This command opens and closes the File Transfers window.

• Rebuild Network Connections

This command causes Renderama to regenerate all of its network 
connections. All currently open connections are closed, and 
Renderama attempts to connect to remote nodes in the same 
fashion as when it starts up. This command can be used if you 
are having difficulty connecting to a particular remote machine.

• Remote Launcher…

This command opens a dialog box, as shown in Figure 14.20, 
that can be used to launch Renderama on remote machines.

Figure 14.20   Remote Launcher dialog box
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In order to use the remote launcher, you must have Application 
Linking privileges on each remote machine, and you must have 
the remote machines’ volumes containing Renderama mounted 
as icons on your desktop.

Using the remote launcher’s Open File window, navigate to 
Renderama on each of the remote machines, and click Add to 
add Renderama to the Files to Launch: list at the bottom of the 
window.

When you have selected all of the remote Renderama’s to be 
launched, click Launch to launch them on the remote machines.

If a password has been set up for your Application Linking 
privileges in the Users & Groups Control Panel, then you will be 
prompted to enter that password the first time you try to launch 
to each remote machine.

• Quit

This command shuts down Renderama.

The Edit Menu This menu offers the standard editing actions: Undo, Cut, Copy, 
Paste, and Clear. These commands can be applied to any edit box in 
Renderama’s windows or dialog boxes.

The Project Menu This menu is used to install or remove all files related to an 
ElectricImage project across the network. Its commands are:

• Install…

This command is enabled when Renderama is in either User or 
Server mode. It allows you to transfer a project’s texture map, 
model and plug-in files across the network before actually 
submitting a rendering job. Installing a project’s related files in 
advance is not required, however, since the files will be 
transferred automatically if necessary when you submit a 
rendering job. This feature is provided mainly as a convenience.

Upon selecting Install… in the Project menu, you will be 
prompted with a dialog box to select an ElectricImage project 
file. If you choose a project file and then click Install in the 
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dialog box, the selected project file will be searched to determine 
the project’s related texture maps, models, and plug-in files.

If you are in User mode and you have chosen a remote render 
server, then you are also given the option to Propagate Files to 
Connected Slaves when you select a project to install. The 
default setting copies the project’s maps, models and plug-ins to 
the remote server which in turn propagates the files to all slave 
machines connected to the server. If you deselect the “Propagate 
Files” check box, then the files are only copied to the remote 
server and no further.

If you are in Server mode, then installing a project’s files 
automatically copies the files to each connected slave machine.

• Remove…

This command is enabled when Renderama is in either User or 
Server mode. This command allows you to delete all texture 
maps, models, and plug-ins relating to one or more projects that 
you have rendered over the network. This feature is useful for 
cleaning old files from the disk drives of networked server and 
slave machines.

Upon selecting “Remove…” in the Project menu, you will be 
prompted with a dialog box to select one or more projects to 
remove. If you are in User mode then the dialog will simply list 
all projects that you have rendered using the currently chosen 
render server.

When you click the “Remove” button in the dialog box, the 
selected project’s texture maps, models, and plug-ins will be 
deleted from the chosen render server’s disk as well as from the 
disk’s of all slave machines currently connected to the render 
server. Note that the original project file, its texture map, model, 
plug-in files will never be deleted, only the copies of these files 
that were transferred across the network are deleted.

If you are in Server mode, you will be prompted with a slightly 
different dialog box that displays a list of each user that has 
rendered or installed projects on the local server.
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The Job Menu This menu is used to change the state of rendering jobs in either a 
local or remote render server’s job queue.

The Job menu is disabled until one or more jobs are selected in the 
Main window’s job queue. All commands in the Job menu are 
applied to the currently selected jobs in Renderama’s Main window.

• Abort

This command removes all selected jobs from the server’s job 
queue, and terminates all current rendering of the selected jobs.

• Suspend

This command puts the selected jobs into a suspended state. Any 
current rendering tasks for the selected jobs are allowed to 
complete, but no new processing is performed for a job in a 
suspended state. If there are other jobs in the server’s queue that 
are not currently suspended, they will be processed as usual.

• Resume

This command puts any selected jobs that are currently 
suspended back into an active state. Partially rendered jobs will 
continue from the point where they were last suspended. When 
Renderama is used in Standalone mode to perform batch 
rendering, jobs are automatically added to Renderama’s job 
queue in a suspended state. For local rendering of queued jobs to 
begin, the user must select the jobs in the queue and choose the 
“Resume” command in the Job menu.
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Renderama Glossary

Term Definition

Job A request by a user to have a specified range of frames from one of the 
user’s projects rendered into an animation.

Project A discrete animation project by a single animator. In a production 
environment a project is also referred to as a “shot.” To confuse things a 
bit, the term project is also used as an abbreviation for “Project File”.

Project File The file that ElectricImage uses to store all the information an animator 
needs to compose an animation. This information includes references to 
the project’s model, map, sound, and plug-in files as well as information 
about the project’s camera, lights, motion paths, deformations, and so on.

Project-related files 
(the project’s files)

Any files that might be required to compose and render an animation. 
These files may include:

1. The project’s model files
2. The project’s assorted map files
3. The project’s sound files
4. The plug-ins used in the project.

Server A computer that is primarily dedicated to running Renderama in Server 
mode.

Server Mode One of the modes in which Renderama can be configured to execute. 
Server mode exists primarily to reduce the amount of file transferring load 
an animation machine must incur. Once a project’s files have been 
transferred from an animation machine to a server, the animation machine 
is free from any further rendering demands. Additionally, server mode 
maintains a queue of rendering jobs, and takes care of dividing jobs into 
tasks, distributing tasks to the available slave machines, retrieving the 
finished frames from the slaves, and assembling them into a complete 
animation.

Slave A computer that is primarily dedicated to rendering animations.

Slave Mode One of the modes in which Renderama can be configured to execute. 
Slave mode launches Camera on the local machine in order to complete 
rendering tasks that are sent from a server.

Standalone Mode One of the modes in which Renderama can be configured to execute. 
Standalone mode allows the user to queue multiple jobs for batch 
rendering on the local machine.
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Task A request by a server to have a specified range of frames from a job 
rendered by a slave machine.

User Synonymous with “animator.” An individual who spends a lot of time 
using ElectricImage, and wishes to spend less time watching Camera’s 
status windows.

User Mode One of the modes in which Renderama can be configured to execute. User 
mode is designed to meet the needs of animators who wish to take 
advantage of network rendering with as little effort as possible.

Term Definition
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A
Abort command

Job menu
Renderama 14-31

Adaptive Load Balancing option
Renderama Preferences window 

14-15
All + Locked command

Select menu 10-8
All command

Select menu 10-7
Amplitude control

Jolt effect 7-7
Spring effect 7-6

Ancestors of Selected command
Select menu 10-8

Anti-Alias Level pop-up menu
In Render Control window 5-2

Anti-aliasing 5-1 to 5-4
Sampling levels 5-2 to 5-3

AppleTalk Networking option
Renderama Preferences window 

14-11
AppleTalk Zones list

Renderama Preferences window 
14-11

Assembled into Complete Animation 
option

Renderama Preferences window 
14-14

Attack control
Spring effect 7-6

Attack Interval control
Spring effect 7-6

Automatic option
In Sampling Level pop-up menu 5-3

Automatic Screen Depth option
Display command preferences 6-5

Automatically open finished 
animation option

Renderama Preferences window 
14-14

Avid Technology, see OMFI format

B
Batch rendering, see Renderama™
Bicubic Detail control

In Smoke Info window 4-8
Blob Threshold control

Mr. Blobby plug-in 8-6
Branches 2-5

C
Camera command

Select menu 10-7
Camera option

Mesh Resolution options
Mr. Blobby plug-in 8-7

Camera view
Previewing 6-6 to 6-7
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Center Image on Screen option
Display command preferences 6-5

Chains 2-5
Change Background Color option

Display command preferences 6-5
Children of Selected command

Select menu 10-7
Color Display pop-up menu

Display command preferences 6-5
Configuration options

Renderama Preferences window 
14-11 to 14-12

Constraint Multipliers settings
In Kinematics Preferences dialog 

box 2-28
Contrast control

In Smoke Info window 4-7

D
Darkness control

In Light Info window 4-2
Decay control

Jolt effect 7-7
Spring effect 7-6

Decay Interval control
Spring effect 7-6

Density control
In Smoke Info window 4-7

Dicer plug-in 8-2 to 8-3
Global Coordinates option 8-3
Local Coordinates option 8-3
Segment Count option 8-3
Segment Length option 8-3
Triangulate option 8-3

Display an alert box when jobs are 
completed option

Renderama Preferences window 
14-14

Display command 6-2 to 6-5
Preferences 6-4 to 6-5

Automatic Screen Depth option 
6-5

Center Image on Screen option 
6-5

Change Background Color option 
6-5

Color Display pop-up menu 6-5
Display Components in Gray 

option 6-5

Display Images in Screen option 
6-5

Display Images in Windows 
option 6-5

Hardware Alpha Overlay option 
6-5

Invert Alpha option 6-5
Premultiply Alpha option 6-5
Select Display Monitor control 

6-5
Display Components in Gray option

Display command preferences 6-5
Display Images in Screen option

Display command preferences 6-5
Display Images in Windows option

Display command preferences 6-5
Display location 6-8
Display window 6-2 to 6-3
Drift control

In Smoke Info window 4-8

E
Edit menu

Renderama 14-29
Effector icon 3-4
Effector Info window 3-5

Style pop-up menu 3-5
Effectors 3-3 to 3-5

Adding to project 3-4
Effector Info window 3-5

Style pop-up menu 3-5
Icon in Object Palette 3-4

Effectors command
Select menu 10-7

EI option
Mesh Resolution options

Mr. Blobby plug-in 8-7
Enable Ray option

In Light Info window 4-3
Enabled option

Remote TCP/IP Hosts
Renderama Preferences window 

14-20
Exporting models 12-1 to 12-2

Start frame 12-2
Stop frame 12-2

F
Facet Blob Scale control

Mr. Blobby plug-in 8-7

Facet Blobs option
Generate options

Mr. Blobby plug-in 8-6
File menu

Renderama 14-28 to 14-29
Preferences command 14-28
Quit command 14-29
Rebuild Network Connections 

command 14-28
Remote Launcher command 

14-28 to 14-29
Show File Transfers command 

14-28
File Transfers window

Renderama 14-27
Find Again command

Select menu 10-7
Find All command

Select menu 10-7
Find command

Select menu 10-7
Finished Frame options

Renderama Preferences window 
14-14

Assembled into Complete 
Animation option 14-14

Remain on Slave Machines 
option 14-14

Fixed Size Tasks option
Renderama Preferences window 

14-16
Formulas

Percentage value changes 11-4 to 
11-5

Relative offset value changes 11-4 to 
11-5

Frequency control
Jolt effect 7-7
Spring effect 7-6

G
Gamma 9-3 to 9-7

Input gamma 9-6
Monitor gamma 9-4, 9-5
Output gamma 9-7

Global Coordinates option
Dicer plug-in 8-3

Global Gravity setting
In Kinematics Palette 2-29
In Kinematics Preferences dialog 

box 2-27, 2-28
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Group Blobs option
Generate options

Mr. Blobby plug-in 8-6
Groups command

Select menu 10-7

H
Hardware Alpha Overlay option

Display command preferences 6-5
Hidden command

Select menu 10-7

I
IK mode, see Inverse Kinematics tool
IK, see Inverse kinematics
Image files

Converting to OMFI format 13-1
Display location 6-8
Display preferences 6-4 to 6-5
In Display window 6-2 to 6-5
Previewing Camera view 6-6 to 6-7

ImageOMFI application 13-1
Incoming Message Queue Size control

Renderama Preferences window 
14-17

Input gamma 9-6
Install command

Project menu
Renderama 14-29

Interpolate Color option
HSV

Mr. Blobby plug-in 8-5
RGB

Mr. Blobby plug-in 8-5
Inverse command

Select menu 10-7
Inverse kinematics 2-3 to 2-30

Branches 2-5
Chains 2-5
Inverse Kinematics tool 2-15 to 2-25
Joint limits 2-9 to 2-11

Joint libraries 2-12 to 2-14
Joint Position Limit controls 2-11
Joint Rotation Limit controls 2-10

Stiffness 2-10
Viscosity 2-10

Local Gravity controls 2-11
Joint position 2-6, 2-7
Link type 2-8
Preferences 2-26 to 2-30

Constraint Multipliers settings 
2-28

Global Gravity setting 2-27, 2-28, 
2-29

Phantom Joint setting 2-27, 2-29
Solution Option settings 2-28
World Orientation setting 2-27, 

2-29
Inverse Kinematics tool 2-15 to 2-25

Cursor icon 2-15, 2-25
Invert Alpha option

Display command preferences 6-5

J
Job menu

Renderama 14-31
Abort command 14-31
Resume command 14-31
Suspend command 14-31

Joint libraries 2-12 to 2-14
Joint limits 2-9 to 2-11

Joint libraries 2-12 to 2-14
Joint Position Limit controls 2-11
Joint Rotation Limit controls 2-10

Stiffness 2-10
Viscosity 2-10

Local Gravity controls 2-11
Joint position 2-6, 2-7
Joint Position Limit controls

In Group Link window 2-11
Joint Rotation Limit controls

In Group Link window 2-10
Jolt effect 7-7 to 7-8

Amplitude control 7-7
Decay control 7-7
Frequency control 7-7
Relative option 7-8
Reverse option 7-8

K
Kinematics Palette 2-29 to 2-30

Global Gravity setting 2-29
Phantom Joint setting 2-29
World Orientation setting 2-29

Kinematics, see Inverse kinematics

L
Launch Projector when jobs are 

completed option

Renderama Preferences window 
14-14

Lens flare obscuration 4-10
Light rays 4-3 to 4-4

Enable Ray option 4-3
Ray Factor control 4-4
Ray Sample control 4-4

Lighting effects
See Lens flare obscuration
See Light rays
See Shadow darkness
See Smoke

Lights command
Select menu 10-7

Limit control
In Smoke Info window 4-7

Linear Detail control
In Smoke Info window 4-8

Link type 2-8
Local Coordinates option

Dicer plug-in 8-3
Local Gravity controls

In Group Link window 2-11
Local Password control

Renderama Preferences window 
14-12

Local TCP Port control
Renderama Preferences window 

14-12
Locked command

Select menu 10-7

M
Machine Info window

Renderama 14-26
Main window

Renderama 14-22 to 14-25
In Server mode 14-23 to 14-24
In Slave mode 14-25
In Standalone mode 14-25
In User mode 14-22

Mesh with Cubes option
Mr. Blobby plug-in 8-5

Mesh with Tetrahedrons option
Mr. Blobby plug-in 8-5

Mist control
In Smoke Info window 4-7

Model command
Select menu 10-7

Models
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Exporting 12-1 to 12-2
Start frame 12-2
Stop frame 12-2

Monitor gamma 9-4, 9-5
Mr. Blobby plug-in 8-4 to 8-8

Blob Threshold control 8-6
Facet Blob Scale control 8-7
Generate options

Facet Blobs option 8-6
Group Blobs option 8-6
Sphere option 8-5
Three Spheres option 8-5
Torus option 8-5
Vertex Blobs option 8-6

Interpolate Color option
HSV 8-5
RGB 8-5

Mesh Resolution options
Camera option 8-7
EI option 8-7

Mesh with Cubes option 8-5
Mesh with Tetrahedrons option 8-5
Texture Map Each Blob option 8-5
Texture Map Whole Model option 

8-5
Vertex Blob Size control 8-6

Multi-frame model exporting 12-1 to 
12-2

Start frame 12-2
Stop frame 12-2

N
Network rendering, see Renderama
Network Timeout Duration control

Renderama Preferences window 
14-18

Networking options
Renderama Preferences window 

14-17 to 14-20
Noise control

In Smoke Info window 4-7
None command

Select menu 10-7

O
Octave control

In Smoke Info window 4-8
Offspring of Selected command

Select menu 10-8
OMFI format 13-1

Output gamma 9-7

P
Parent of Selected command

Select menu 10-7
Percentage value changes 11-4

Formulas 11-4 to 11-5
Phantom Joint setting

In Kinematics Palette 2-29
In Kinematics Preferences dialog 

box 2-27
Phase control

Spring effect 7-6
Plug-ins 8-1 to 8-8

Dicer 8-2 to 8-3
Mr. Blobby 8-4 to 8-8

Position control
In Smoke Info window 4-7

Preferences command
File menu

Renderama 14-28
Preferences window

Renderama 14-10 to 14-20
Configuration options 14-11 to 

14-12
Networking options 14-17 to 

14-20
Server options 14-15 to 14-16
User options 14-13 to 14-14

Premultiply Alpha option
Display command preferences 6-5

Preview Depth control
In Smoke Info window 4-9

Preview Offset controls
In Smoke Info window 4-9

Project menu
Renderama 14-29 to 14-30

Install command 14-29
Remove command 14-30

Q
Quit command

File menu
Renderama 14-29

R
Random Range control

Randomize effect 7-4
Randomize effect 7-4

Random Range control 7-4

Relative option 7-4
Seed control 7-4

Ray Factor control
In Light Info window 4-4

Ray Sample control
In Light Info window 4-4

Rebuild Network Connections 
command

File menu
Renderama 14-28

Relative offset value changes 11-4
Formulas 11-4 to 11-5

Relative option
Jolt effect 7-8
Randomize effect 7-4
Spring effect 7-6

Remain on Slave Machines option
Renderama Preferences window 

14-14
Remote Address value

Remote TCP/IP Hosts
Renderama Preferences window 

14-19
Remote Launcher command

File menu
Renderama 14-28 to 14-29

Remote Password value
Remote TCP/IP Hosts

Renderama Preferences window 
14-20

Remote TCP Port value
Remote TCP/IP Hosts

Renderama Preferences window 
14-20

Remote TCP/IP Hosts list
Renderama Preferences window 

14-19 to 14-20
Enabled option 14-20
Remote Address value 14-19
Remote Password value 14-20
Remote TCP Port value 14-20

Remove command
Project menu

Renderama 14-30
Render Server list

Renderama Preferences window 
14-13

Renderama™ 14-1 to 14-33
Configurations 14-2 to 14-20

Examples 14-6 to 14-9
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Server mode 14-2, 14-3, 14-4 to 
14-5

Slave mode 14-2, 14-3, 14-5
Standalone mode 14-2, 14-3, 14-5
User mode 14-2, 14-3, 14-4

Defined 14-1
Edit menu 14-29
File menu 14-28 to 14-29
File Transfers window 14-27
Installation 14-2
Job menu 14-31
Machine Info window 14-26
Main window 14-22 to 14-25

In Server mode 14-23 to 14-24
In Slave mode 14-25
In Standalone mode 14-25
In User mode 14-22

Preferences window 14-10 to 14-20
Configuration options 14-11 to 

14-12
Networking options 14-17 to 

14-20
Server options 14-15 to 14-16
User options 14-13 to 14-14

Project menu 14-29 to 14-30
Rendering

Batch, see Renderama™
Network, see Renderama™

Rendering Distribution Method 
options

Renderama Preferences window 
14-15

Adaptive Load Balancing option 
14-15

Fixed Size Tasks option 14-16
Rendering Task Size slider

Renderama Preferences window 
14-16

Resume command
Job menu

Renderama 14-31
Reverse option

Jolt effect 7-8
Spring effect 7-6

Rotation control
In Smoke Info window 4-7

S
Samples control

In Smoke Info window 4-7
Sampling Level pop-up menu

In Group Info window 5-3
Automatic option 5-3

In Render Control window 5-2
Sampling levels 5-2 to 5-3
Scale control

In Smoke Info window 4-7
Seed control

Randomize effect 7-4
Segment Count option

Dicer plug-in 8-3
Segment Length option

Dicer plug-in 8-3
Select Display Monitor control

Display command preferences 6-5
Select menu 10-3 to 10-8

All + Locked command 10-8
All command 10-7
Ancestors of Selected command 

10-8
Camera command 10-7
Children of Selected command 10-7
Effectors command 10-7
Find Again command 10-7
Find All command 10-7
Find command 10-7
Groups command 10-7
Hidden command 10-7
Inverse command 10-7
Lights command 10-7
Locked command 10-7
Model command 10-7
None command 10-7
Offspring of Selected command 

10-8
Parent of Selected command 10-7
Visible command 10-7

Server mode
Renderama configurations 14-2, 

14-3, 14-4 to 14-5
Server options

Renderama Preferences window 
14-15 to 14-16

Shadow darkness 4-2
Darkness control 4-2

Show File Transfers command
File menu

Renderama 14-28
Show Smoke Object option

In Smoke Info window 4-7
Size control

In Smoke Info window 4-7

Slave mode
Renderama configurations 14-2, 

14-3, 14-5
Smoke 4-5 to 4-9

Smoke Info window 4-6 to 4-9
Smoke object 4-5 to 4-9

Smoke Info window 4-6 to 4-9
Bicubic Detail control 4-8
Contrast control 4-7
Density control 4-7
Drift control 4-8
Limit control 4-7
Linear Detail control 4-8
Mist control 4-7
Noise control 4-7
Octave control 4-8
Position control 4-7
Preview Depth control 4-9
Preview Offset controls 4-9
Rotation control 4-7
Samples control 4-7
Scale control 4-7
Show Smoke Object option 4-7
Size control 4-7
Turbulence option 4-8

Smoke object 4-5 to 4-9
Solution Option settings 2-28
Sphere option

Generate options
Mr. Blobby plug-in 8-5

Spring effect 7-5 to 7-6
Amplitude control 7-6
Attack control 7-6
Attack Interval control 7-6
Decay control 7-6
Decay Interval control 7-6
Frequency control 7-6
Phase control 7-6
Relative option 7-6
Reverse option 7-6

Standalone mode
Renderama configurations 14-2, 

14-3, 14-5
Start frame

Model export 12-2
Stiffness control

In Group Link window 2-10
Stop frame

Model export 12-2
Style pop-up menu

In Effector Info window 3-5
ElectricImage™ Version 2.5 Supplement IX-5
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Suspend command
Job menu

Renderama 14-31

T
TCP/IP Networking option

Renderama Preferences window 
14-11

Texture Map Each Blob option
Mr. Blobby plug-in 8-5

Texture Map Whole Model option
Mr. Blobby plug-in 8-5

Three Spheres option
Generate options

Mr. Blobby plug-in 8-5
Torus option

Generate options
Mr. Blobby plug-in 8-5

Triangulate option
Dicer plug-in 8-3

Turbulence option
In Smoke Info window 4-8

U
User mode

Renderama configurations 14-2, 
14-3, 14-4

User options
Renderama Preferences window 

14-13 to 14-14

V
Value changes

Formulas 11-4 to 11-5
Percentage 11-4
Relative offset 11-4

Vertex Blob Size control
Mr. Blobby plug-in 8-6

Vertex Blobs option
Generate options

Mr. Blobby plug-in 8-6
Vibe 7-3 to 7-8

Jolt effect 7-7 to 7-8
Randomize effect 7-4
Spring effect 7-5 to 7-6

Viscosity control
In Group Link window 2-10

Visible command
Select menu 10-7

W
World Orientation setting

In Kinematics Palette 2-29
In Kinematics Preferences dialog 

box 2-27
IX-6 ElectricImage™ Animation System
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